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Standard Elements
Standard Elements are those functions and features which are common to a number of 
modules in Calamus. A few examples include: color and fill patterns for text and objects are 
handled by the Color Settings module; file selection is done through the Calamus File 
Selector or Windows File Selector; fonts, graphics and text are imported using the Calamus 
Object Selector. 

Menus are also considered standard elements within Calamus since they are common to all 
modules. Information about the various menus is found in the respective sections of the 
Menus chapter: File, Options, Edit, Window and Help. Further information on Standard 
Elements is available here.
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Modules Overview
Each Calamus module contains functions grouped for similar yet specific tasks. For example,
textbased functions are in the Text module. Functions for laying out frames are in the Frame 
module.

Module Organization 

The basic Calamus system comes with many modules that would be optional purchases in 
other applications. The following popups provide an overview of the modules included in the 
Calamus package.

Floating Pallette 
Frame Special Functions 
Module Overview in Brief 



Module Overview in Brief
Blend Module Overview
Brush Module Overview 
Clipboard Module Overview 
Color List Converter Module Overview 
Color Separation Module Overview 
Color Settings Module Overview 
CYMK Swap Module Overview 
Document Converter Module Overview 
EPS Handler Module Overview 
Focoltone Module Overview 
Font Load Module Overview 
Frame Module Overview 
Line Module Overview 
Linearity Module Overview 
Mask Module Overview 
Mount Module Overview 
OLE Module Overview 
Page Module Overview 
Page Preview Module Overview 
Raster Area Module Overview 
Raster Generator Module Overview 
Rotation Module Overview 
Scanner Module Overview 
StarScreening Module Overview 
Systems Parameters Module Overview 
Text Editor Module Overview 
Text Module Overview
Text Style Module Overview 
Toolbox Module Overview 
Vector Editor Module Overview 
Windows Clipboard Module Overview 



Toolbar

This section examines the Toolbar icons in the top right portion of the screen, including
Display Sizes, Set Magnification, Zoom, Page Preview, Page Numbering, Page Indicators, 
Master Page, Key Bindings and Coordinate Display.

The first group of 3 icons changes the display size of the document; the next group of 3 
icons provides a magnified view of a selected area, page preview and the ability to set the 
magnification factor. The third group of icons provides access to any layout or master page; 
the fourth group displays key bindings for macros. The Coordinate Display at the end of the 
Toolbar facilitates precise placement and drawing of frames.
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Command Structure
Calamus is based on a command system of menus and loadable modules organized in a 
hierarchy of icons. Information about the menus is found in the Menus chapter; modules are 
dealt with in their own chapters. 

Calamus has over 1000 functions in its standard package. These functions are accessed 
from menus and command icons. Menu functions are described in Menus, chapter 2. The 
system of standard iconbased functions is described within Standard Elements.



Module Row

The Module Row is the area located at the top left of the screen where the icons for each 
loaded module are visible. Like all function groups, the Module Row is a floating palette 
which may be moved anywhere on the screen. 

The Module Row generally displays 10 icons that can be resized to show up to 42 icons. It is 
not necessary that all modules loaded in memory be displayed as they can be easily 
accessed using the scroll arrows.



Selectors
Calamus has two custom selectors for dealing with various components of its system. The 
Calamus File Selector is used for loading documents, fonts and setup files. It will replace the 
standard Windows file selector if it is chosen in the System Parameters module. 

The second custom selector is the Calamus Object Selector which is used for import/export 
drivers, font management, master pages and color lists. The components of each custom 
selector are described below.

Calamus File Selector 
Calamus Object Selector 



Calamus File Selector
The Calamus File Selector is a standard element that is used by a number of functions. In all 
cases, the Calamus File Selector will have the same appearance and method of use. In order 
to save or load information, proper file names must be used. Enter an appropriate file name 
and click OK; the threeletter extension for a document, CDK, will be automatically assigned. 
The extension indicates the type of information stored in a file. The computer's operating 
system uses a combination of directories and files. Calamus enhances the file management 
system by adding titles and other features to its file selector.

The title bar at the top of the file selector identifies the function which called up the file 
selector; in our example, Open Document.

Under the title bar is the letter of the current drive followed by 11 icons for various file types
and functions. Below that, the current available drive partitions are indicated, followed by 
the Selection field in which the filename and path are entered. Below and to the left are two 
icons: the first displays all files; the second displays a specific file type, in this case, CDK. To 
the right the files in the current path are listed.

File Selector Elements 
File Selector List 
File Selector OK and Cancel Buttons 
File Selector Types 





File Selector Elements
The selection of a drive partition is made by clicking the downarrow. This will show the 
available drives. Click the drive needed and the directory will immediately be updated.

Eleven functions are available by clicking their icons:

1 Connect to network drive  7 Copy files and directories
2 Disconnect from network drive  8 Move file
3 Sort files by name     9 Delete files and directories
4 Sort files by type 10 Rename file
5 Sort files by size 11 Create directory
6 Sort files by time and date

To copy a file or directory, click its name and then click the copy icon. Enter the appropriate 
information as illustrated in this dialog box. If you wish to move, delete or create a directory,
another dialog box will appear prompting you to enter the appropriate information. If you 
wish to rename a file, click the file to be changed and then click the Rename icon. A dialog 
box will appear requesting the new filename.

The next series of buttons represents the drives currently connected. In our example, drive a
is the floppy drive; drives c and d are partitions on the hard drive; drive e is the CDROM 
while drive n represents the network. 

The Selection field shows the current path and filename. First is the drive letter, followed by 
directory names separated by a backslash [\]. Every time you select a new directory from 
the file display, Calamus will add it to the end of the pathname. You may enter a pathname 
using the keyboard instead of entering it with the mouse. Click the mouse in the input field, 
or move the text cursor to the field by using the arrow keys or [Tab] key. When you have 
finished input, press [Enter]. Unlike other file selectors, the Calamus File Selector will not 
disappear when you press [Enter]; rather, it will read the new pathname and update the 
display. When you are using the Calamus File Selector to Set System Paths, Calamus will use 
the pathname shown and ignore any filename.



Calamus Object Selector
The Calamus Object Selector is used to load fonts, modules and import/export drivers for 
text and graphics.

Depending on the function selected, the object selector will have one of the following title 
bars:

 Load Fonts
 Export Raster Graphic
 Export Text
 Export Vector Graphic
 Import Raster Graphic
 Import Text
 Import Vector Graphic
 Modules

In addition to the usual 8character filenames, fonts, modules and import/export drivers have
more descriptive 26character names. The longer names are visible in the object selector 
window. The object selector displays a list of names related to the current object type. There 
are also options to Delete, Delete All, Load, Replace and Import or Export.

Object Selector - Delete All from 
Object Selector - Delete from 
Object Selector - Execute from 
Object Selector - Exit from 
Object Selector - Import or Export from 
Object Selector - Load from 
Object List 
Object Selector - Replace from 



Object List
In the Object List, you can select an object by clicking its name. This applies to fonts, 
modules and drivers. You can select more than one item by clicking the filenames while 
holding down the [Shift] key. Selected items (fonts, modules or drivers) will appear in inverse
video. 

If there is not enough room to display all the fonts, modules or drivers, use the arrows or the 
vertical scroll bar to move through the list. You can activate modules and drivers by double-
clicking their file name. 



Object Selector - Delete from
Clicking this button allows you to remove a selected font, driver or module from the object 
list. There are, however, a few restrictions. When you delete a font currently in use in a 
document, you must supply a replacement font. At least one font must remain in memory. 
Changing a font can affect text formatting (see Load Font in the Text Style Module, chapter 
5). 



Object Selector - Delete All from
Clicking this button deletes all modules and import/export drivers from memory. Since one 
font must    remain in memory, this function will delete all fonts except one which you must 
select. All text will be formatted in the remaining font.



Object Selector - Load from
Clicking this button allows you to enter a new font, module or driver in an object list. When 
you click Load, the Calamus file selector will appear and you can select which font(s), 
module(s) or driver(s) you want to load. If you want to load several fonts, modules or drivers 
at the same time, hold down the [Control] key while selecting them. When you click OK or 
press [Enter], Calamus will add the new item(s) to the object list.



Object Selector - Replace from
If at least one item in a list is selected, this function will delete the selected item(s) first, and
replace it with another item that you are prompted to select. For example, you may wish to 
replace one font with another. Select the font to be replaced, click the Replace button; then 
click the name of the replacement font. Changing fonts may affect text formatting. 



Object Selector - Import or Export from
These buttons allow you to import or export files in the format of the selected object type.



Object Selector - Execute from
This button allows you to execute (activate) or access modules directly from the Calamus 
Object Selector.



Object Selector - Exit from
This button will close the Calamus Object Selector and return you to the document or editor 
window.



File Selector Types
As mentioned, a filename is followed by a period and a 3character extension which 
describes the file type. All files which hold the same type of data should have the same 
extension. Calamus documents have the extension CDK, fonts have the extension CFN, etc. 
In the file list, the Calamus File Selector will show only files with the currently selected 
extension. An asterisk before the period (e.g. *.CDK) means that all files of this type will be 
shown, while a star before and after the dot (*.*) means that all files of any type will be 
shown. For more information on the ? and * wildcards, see your computer manual. To change
the current file type, click the icon for a new type and the file list will show only files with the
selected extension.



File Selector List
The file list shows the name, type, size and creation date/time for each file which matches 
the currently selected extension. Directories appear with their names and date/time only. 
They are marked with the folder icon. As only 15 filenames can be displayed in a single 
window, the arrow icons and vertical scroll bar on the right side of the display allow you to 
scroll so that you can see files not currently visible. If you click the top line of the file list, you
will close the current directory and move back to the previous one. If you click any directory 
line, you will open the directory and show the files in it. A single click on a filename will enter
its name in the Selection field to the right. You can also enter a filename. When creating a 
new file, you will have to type in the name so that you do not overwrite an existing file. 
When you doubleclick a filename, you will select that file and quit the file selector. A double-
click works the same as a single click on a filename, followed by a click on the OK button.



File Selector OK and Cancel Buttons
Clicking the OK button closes the file selector. Calamus will load the file whose name you 
selected or typed in. You can press [Enter] to activate the OK button, as long as the text 
cursor is not in the Path field. You can also quit the file selector by doubleclicking a filename.
If you click the Cancel button, no file will be loaded or saved, and the file selector will 
disappear.



Color Settings
A number of Calamus modules access this module to create and edit colors. 
Color is such an important element in Calamus that chapter 3, Color, has been devoted to it.



Example - Replace Name
Here is an example to show how Replace works: You are merging two documents, A and B. 
Document A has a master page named Master Page 1 that is blank. Document B has a 
master page named Master Page 1 that contains graphics and lines. When you merge 
Document B into Document A, a name conflict occurs. If you select Replace, the master 
page in Document A is retained, replacing the master page in Document B.

In general, use Rename if you are uncertain that objects with conflicting names are identical.
If they are identical, use Replace to avoid the confusion of having identical objects with 
different names.

Apply to Following Objects will automatically Rename or Replace any more name conflicts 
within the current object type. For example, if you wish to Replace the names of several 
colors in a color list, click the Apply to Following Objects button and then click Replace. 
When replacements have been made, the Name Conflict dialog box will display the next 
object type in which a name conflict occurs. You can also use the Apply to Following Objects 
button with Rename to automatically rename all names that conflict within the current 
object type.



Clipboard Module Overview

 You can place any frame type, text or text ruler here and retrieve it later. Other modules
also use clipboards for storing different types of data. Unlike most other modules, the 
Clipboard module cannot be deleted. See also Windows Clipboard Module.



Page Module Overview

 This module allows you to define page layout, page format, page and chapter 
numbering, and document processing.



Frame Module Overview

 This module contains commands for creating and editing frames and guidelines. Some 
frame types also have special functions. You can also choose the display mode for each 
frame type.



Text Module Overview

 This module is used for entering, formatting and piping text.



Text Style Module Overview

 Text Style controls the selection, size, color, attributes and effects of fonts.



Line Module Overview

 This module offers functions for the creation and manipulation of lines, arrows, curves 
and corners.



Raster Area Module Overview

 This module allows you to work with circles, rectangles and other shapes. You can also 
select color settings for shapes.



Raster Generator Module Overview

 This module is used to set line frequency for high resolution output. In Calamus it is    
possible to set different line frequencies for each frame on a page. This maximizes the 
quality of output for graphics, line art and text.



Color Separation Module Overview

 This module allows you to configure colorseparated output for maximum quality. 
Separations can be done for individual frames, pages or an entire document. 



Mount Module Overview

 This module is a basic page imposition tool that allows you to print pages in an orderly
and economic manner. 



Text Editor Module Overview

This module edits text using wordprocessing features such as Search and Replace and 
Block functions. You can also insert layout and text control codes. A number of options can 
be configured to your preference to make it easier to work in the Text Editor.



Toolbox Module Overview

 This module contains two sets of functions: the first set is used to align frames with 
each other and to move to/from the master page; the second set is used to convert a frame 
to another frame type.



Vector Editor Module Overview

 This module contains functions for creating vector objects; editing vector paths and 
points; and selecting color settings for vector objects and their borders.



Mask Module Overview

 This module is used to create special effects when masking one frame or object on 
another. There is also an inverse function within this module.



Blend Module Overview

 This module is used to create smooth gradient color blends within a raster graphic 
frame. These blends can have two or three color inputs and can be angled in any direction. 
This module can also create rectangular and circular color blends.



OLE Module Overview

 This module supports Object Linking and Embedding functions that allow text and 
graphic data to be shared between Calamus and other OLE applications.



EPS Handler Module Overview

 With this module, you can import EPS graphic files into Calamus uniframes.



Rotation Module Overview

 This module allows the precise rotation of bitmap graphics and includes a powerful anti-
aliasing feature.



Linearity Module Overview

 With this module you can define printer gradient curves to calibrate color output on a 
color printer.



Scanner Module Overview

 This module is used with optional scanner drivers that allow the scanning of color 
images directly into a raster graphic frame.



Brush Module Overview

 This module is used to edit bitmapped graphics and contains brush tools and a color 
palette.



StarScreening Module Overview

 This module applies stochastic screening to any frame up to a maximum resolution of 
600 dpi.



Systems Parameters Module Overview

 This module is used for configuring monitor resolution, system paths and file selectors; it
also allows date and time formats to be chosen. This module is accessed through the 
Iconbar.



Color Settings Module Overview
This module is the hub of Calamus' color control system. It allows the creation and editing of
RGB, CYMK and K colors and can also be used to access color palette modules to create spot
colors.



Focoltone Module Overview

 This color palette module provides access to the Focoltone color matching system. Color 
palette modules are loaded individually and accessed through the Color Settings dialog box.



Color List Converter Module Overview
This module converts free colors in graphics to list colors that can be used by other Calamus
modules, accessed directly from Modules.



CYMK Swap Module Overview

 This module allows the exchange of color plane data to create interesting visual effects 
with color images.



Document Converter Module Overview
This module is used to convert documents from previous versions of Calamus to a format 
that loads into the current version.



Font Load Module Overview
This module is used to load CFN format fonts that have been purchased from DMC.



Page Preview Module Overview

 This module displays a complete document page onscreen without guidelines and 
frame borders.



Windows Clipboard Module Overview
This module integrates with the Windows clipboard system to share text and graphic data 
with other Windows applications.



Module Organization
Most Calamus modules are based on a hierarchy of icons. Each module contains a maximum
of 8 command groups. Each command group contains up to 21 command icons and/or a 
scrollable object list. 

For example, the Text Style module icon leads to its related command groups, and the Font 
Selection command group. In the command group are the object list of font names and the 
command icons used to change text style, load text style and load fonts. Many command 
icons lead to alerts and dialog boxes in which you can choose options and input settings for 
the selected function,



Frame Special Functions
Within the Frame module, there is an additional set of icons in each of four Special Functions
command groups. There are special functions for text, raster graphic, vector graphic and 
tiling frames.



Floating Pallette
Command groups are floating palettes that can be copied and moved around the screen. 
Press [Shift] and click the module's title bar to make a copy. Press [Control] and click the title
bar to delete copy. To move a command group, drag its title bar to a new location.



Name Conflict
This section explains conflicts which may occur when merging documents or loading text 
style lists, color lists or master pages.

In addition to text and graphic frames, Calamus saves other    components in a document. 
These components, known as objects include text style lists, color lists and master pages. 
Objects may also be saved individually and used in other documents. For example, a text 
style list may be used in several CDK files; a set of custom spot colors may be used for a 
series of flyers. There are many possibilities.

When you load an object into a document, some of the names used in the object may 
already exist in the document. For example, the color green may exist in a document's color 
list. If you load another color list that contains a color named green, a name conflict occurs. 
Calamus will not allow two colors to have the same name in the same document - even if 
the colors are slightly different. The same is true of text styles. If you load a text style list 
containing a style named headline into a document that already has headline in its text style
list, a name conflict occurs.

When a name conflict occurs, the Name Conflict dialog box will appear. This dialog box has 
an edit field and three options to overcome the name conflict: Suggest Name, Rename and 
Replace.

The Object field indicates the type of object in which the name conflict occurs. The Current 
Name field displays the name of the object in the current document. The New Name field 
displays the name of the object causing conflict. Since the two objects cannot share the 
same name, the New Name field is editable so that you can change the name of the object 
being loaded. Enter a new name for the object and click the Rename button to apply it.

When you click the Suggest Name button, a suggested name will appear in the New Name 
edit field. The new name is created by adding # and a number to the old name, e.g. green 
#2. If the suggested name is acceptable, click the Rename button to apply it.

The Rename button works in two ways: it will apply the name in the New Name field after 
you have edited it; if you did not edit the name, it will automatically do so by appending a 
number to it. 

Clicking the Replace button causes the old object to replace the new one. This option should 
be used when you are certain that the conflicting objects are identical. If uncertain, use the 
Rename function.

Example - Replace Name 



Shadow Settings
Text and object shadows may be defined by color, offset and direction. Calamus has the 
ability to create shadows for text characters, lines and raster areas. Shadows can have any 
color. You can also offset shadows horizontally, vertically or diagonally. Shadow Settings are 
divided into two groups which control direction and offset.

Shadow Direction 
Shadow Offset 



Shadow Direction
This feature sets shadow direction. Its 9 boxes indicate the choices. The central icon 
represents no shadow, while the eight outer icons represent the eight different shadow 
directions. Select one of the icons to establish the desired direction.



Shadow Offset
The X, Y offset fields control the horizontal (X) and vertical (Y) offset of a shadow. Each offset
can be individually set. Click the offset field and enter a value. Press [Enter] to confirm. If a 
unit of measure is shown, the offset is absolute and the shadow will be created at the 
selected distance. You may also enter an offset that is relative to the shadowed object. 
Relative offset is expressed as %.

To switch from absolute to relative shadow offset for text, click the unit of measure beside 
the number. The unit of measure will change from an absolute unit (pt, mm, etc.) to %. This 
is a percentage of the font size (e.g. for 12 pt text, a 10% shadow will be 1.2 pt).



Control Lines
Control Lines are used to adjust color display and color output.

A Control Line function exists in three modules: Frame, Linearity and Color Separation. While
the Control Line function in each module contains common elements, the use of the various 
Control Line functions is different.

In the Frame module, the Control Line function adjusts individual control lines for the Red, 
Green and Blue colors used in an RGB color image. For a grayscale image, one control line is 
used to adjust the graylevel. Control lines in the Frame module are saved as CK1 for 
grayscale images and CK3 for RGB images. 

In the Linearity module, the Control Line function is used to optimize color output of an RGB 
color image or 4color CYMK image. For a CYMK image, the control lines should be left at the 
neutral setting. Control lines in the Linearity module are saved as CK4 files. 

In the Color Separation module, the Control Line function is used to adjust the seven color 
channels used for Gray Color Removal (GCR) and Under Color Removal (UCR). Control lines 
in the Color Separation module are saved as CK7 files.

In each module, the Control Line function contains standard elements such as a Control Line 
window, a clipboard, Invert and Neutral options, Gamma, Freehand and Bézier options, and 
the ability to Load and Save control lines.

Each Control Line function also has a dropdown color list. In the Frame module, the color list 
contains Red, Green and Blue colors. In the Linearity module, the color list contains Cyan, 
Yellow, Magenta and Black. In the Color Separation module, the color list contains Cyan, 
Yellow, Magenta, Black, Black from Cyan, Black from Yellow and Black from Magenta.



Frame Functions
To select any frame in Calamus, click once with the left mouse button. To deselect a frame, 
three methods are available: 

1. Press the [Esc] key; 

2. Click the right mouse button; 

3. Click the left mouse button on a different frame.

To delete a selected frame, press the [Delete] key or click the trashcan icon in the Tools 
command group of the Frame module. 



Coordinate Display
The last two boxes in the Toolbar form the Coordinate Display. This element allows you to 
see or change the position and size of a frame. X and Y show the horizontal and vertical 
positions of the topleft corner of a frame. The coordinates also reflect the position of the 
cursor except when it is outside the layout window. In the Text module if a text ruler is 
selected, X is the cursor's position from the left edge of the frame; Y is empty. When you 
select a frame, its size will appear in the dX (width) and dY (height) fields. To change the unit
of measure in the Coordinate Display, see Set Units of Measure in the Page Module, chapter 
3.

You can edit the fields in the Coordinate Display to change the size or position of a frame. 
First, select a frame by using the mouse. Next, click the Coordinate Display. You can enter 
numbers or a mathematical formula into an input field. The Coordinate Display provides a 
more precise method for resizing and placing frames than the layout rulers.



Display Sizes

 Clicking the icon shown at left displays the entire page on the screen. If you are using a 
facingpage format, you will see both pages. On a standard 14" monitor, however, you will 
not be able to read the text, since the characters will be only a few pixels high.

 The icon shown at left displays the document at actual size, 1:1. This means that 
everything will appear on the screen in the same size, but not the same resolution, as the 
final printout. If your monitor's resolution is set up correctly in the System Parameters 
module, you can measure items on the screen with a ruler. Only a fullpage monitor can show
an entire page at 1:1 display size. 

 To see details which are fuzzy at actual size, or to see the document pixelbypixel as it 
will appear in the final printout, you can select the third icon for higher magnification. See 
the Set Magnification section below to set the magnification level.

You can switch among these three magnifications without clicking icons. Press the [Control] 
key and click the left mouse button to show the page at 1:1 magnification; press the 
[Alternate] key and click the left mouse button to show the page at the userdefined 
magnification. The place where you click the mouse button will be the center of the 
magnified display.



Key Bindings Display

 These icons indicate the key binding that invokes the function under the cursor, if a key 
binding exists for that function. The boxes represent four special keys - [Control], [Alternate],
[Left Shift] and [Right Shift] which are used with a hot key to call up a function. If the 
character # appears before the hot key, it refers to a key on the numeric keypad rather than
the main keyboard. 

To use a key binding, press the highlighted special key and type the appropriate hot key 
which appears in the bottom of the icon box. See Key Bindings in the Text Module, chapter 5 
for information on defining key bindings. You should also read the information for recording 
your own macros under Macro Recorder in Menus, chapter 2.



Master Page
 When you click the Master Page icon, your document window will display the master page

associated with the current document page. For more information, see Master Page Mode in 
the Page Module, chapter 5.



Page Indicator
 If your document is composed of facing pages, the Left and Right Page icons will 

indicate the position of the current page. The first page of a document is usually a righthand 
page; subsequent pages will alternate between left and right pages. For more information on
working with facing pages, see the Page Module, chapter 5. If your document is in single-
page format, these icons will not be highlighted.



Page Number Display

 This input field shows the current page in a document. You can use the arrows on 
either side of the input field to move forward and backwards from the current page. If you 
click the page number, an input field appears and you can enter a new number to move to a
different page. This page number will not necessarily be the same as the number printed on 
the page, since it is the number of the physical page in the current document, starting from 
page 1.



Page Preview

 Provided that you have loaded the Page Preview module, clicking    this icon will bring up
a fullpage display of your document in both single and facingpage format. Write modes will 
be displayed and    guidelines and margins will not be visible, thereby providing you with a 
true WYSIWYG view of the page.



Magnification - Set
 You can select one of nine predefined magnifications or create three custom 

magnifications. To set a custom magnification, simply change the number in the input field. 
To select a custom magnification, click the button to the left of the appropriate percentage.

The Zoom value shows the last magnification used by the Zoom function described below.

The Printer 1:1 view shows the degree of magnification required in order to have a 1:1 
correspondence between each screen pixel and each printer pixel. To use this function, your 
printer must be online and the correct printer driver must be installed. When you change 
printer drivers, the value in this field will reflect the change.

If you usually work with different printers, for example, draft copies on a laser printer and 
final copies on an imagesetter, you can enter the respective Printer 1:1 magnifications in the
Custom fields. This way, you can select one Custom button to match the imagesetter's 
resolution and another to match the laser printer's resolution.



Zoom

 If you click the Zoom icon, you can zoom into an area on the screen. First, click the 
Zoom icon; the cursor will turn into a magnifying glass. Next, use the magnifying glass to 
draw a box the same way that you would draw a frame. Click the left mouse button once to 
set the topleft corner and a second time to set the bottomright corner. You can abort the 
operation by clicking the right mouse button. Since you can click the window's scroll bars 
during this operation, you can define an area that is larger than the window itself. In this 
case, you will actually shrink the display rather than enlarge it.



Menus
Calamus uses the standard Windows menus to provide access to many of its main elements.
The Menu Bar is located at the top of the screen and contains five menu titles: File, Options, 
Edit, Window and Help. Clicking any menu title will pull down a list of menu items.

As with standard Windows procedures, the menus may also be accessed by holding down 
the [ALT] key and pressing the key for the underlined letter in the menu item. For example, 
[ALT]+[F] calls the File menu; [ALT]+[O] the Options menu, etc.

The File menu accesses functions related to loading, saving and printing files; loading 
modules and importing/exporting data. The Options menu accesses functions that set 
working parameters, define paths and advanced document functions. The Edit menu is a 
standard Windows item that works in conjunction with the Windows Clipboard system. The 
Window menu provides control over the display of document windows with the option to 
show or hide the various palettes of the Calamus system (Module Row, Toolbar, Iconbar, 
Command Groups). The Help menu is another standard Windows feature that provides 
access to the online help messages.

File Menu 
Options Menu 
Edit Menu 
Window Menu 
Help Menu 



File Menu
In the File menu, you will find functions for loading, saving and printing documents. There 
are also commands for accessing Calamus' modules and import/export functions. 

New Document 
Open Document 
Merge Document 
Abandon Changes 
Save Document 
Save Document As ... 
Save All Documents 
Close Document 
Print Document 
File Menu - Modules 
Import 
Export 
Exit 



New Document
Select this menu item to create a new document. You can have as many documents open as 
your system memory allows. These documents will appear in their own window and the title 
of the document will appear in the Window menu.    A new document consists of an empty 
page in the format chosen in the Set Page Format dialog box (Page module). You may 
change page format at any time, so you do not have to select dimensions or format before 
starting a new document. You may even change format when frames are already on the 
page. To switch between the documents in memory, select the name from the Windows 
menu.

When you create a new document, an empty document page appears on screen and the title
bar shows a temporary file name of NONAME1. If you create another new document, it will 
have the file name of NONAME2, etc. You can work with a new document as is, or you can 
change the page dimensions. You cannot create a text frame until at least one font is loaded.
Normally, this will not be a problem, but if Calamus cannot load the first font specified in 
your saved settings, this alert will appear when you attempt to create a text frame: 

You can use the Load Font function to load a font; see Load/Delete Fonts in the Text Style 
Module, chapter 5. 



Open Document
When you click this menu item, the file selector will appear. Select a filename and click OK or
press [Enter]; Calamus will load the document and any associated fonts which are not in 
memory. 

If Calamus cannot find one of the fonts required by the document, the font loading dialog 
box will appear. 

You have four choices: Change Path tells Calamus to look for the fonts in a different location. 
This option affects not only the current font, but all those which follow. If, for example, you 
enter a search path of D:\Calamus, the program will search the Calamus directory for the 
current font. If you have selected Relative System Paths in the System Parameters module, 
Calamus will also search all subdirectories. Try Again searches for the same font in the same 
place as before. This option allows you, for example, to switch CDs if you have not copied 
the fonts to the hard drive. 

Alternate Font allows you to select a different font if you do not have the one required. When
you click this button, the file selector will appear. Try to choose a font with spacing as similar
as possible to the original one. Fonts rarely have identical spacing, so text formatting and 
page breaks may be changed by the new font. A different font can also affect the 
appearance of underlining and other text effects. 

Abort Load will stop loading the document. 



Merge Document
This function joins one document to another. To use this function, at least one document 
must already be open. When you click this menu item, a dialog box will appear: 

The merged document will be loaded Before or After the page specified in the Merge 
Document dialog box. Click Cancel to abort the function, or click OK to continue. When the 
file selector appears, click the name of the document to be merged, then click OK.

If the merged document has the same page dimensions as the current document, all frames 
will appear and be positioned in relation to the topleft corner of the original document. If the 
new document has different page dimensions than the original one, Calamus will use the 
original document's page format. If the merged document is smaller than the original 
document, some frames may not be visible unless you enlarge the page size. Once again, all
frames are positioned in relation to the topleft corner of the original document. When 
merging documents, you may also encounter a situation where you have objects with the 
same name, such as master page, color list and style list. This is likely to occur if a common 
setup was used to create documents. When two documents have identicallynamed 
elements, the Name Conflict dialog box will appear. 

Name Conflict 



Abandon Changes
When you select this menu item, Calamus asks you to confirm that you want to abandon the
changes in the current document. Clicking the Abandon button will delete the document 
from memory and load the last saved version of the document. If you did not save the 
document, Calamus will delete the document from memory and create a new document.



Save Document As ...
Choosing Save Document As... allows you to choose the filename under which you want to 
save a document. When you click this item, the file selector will appear with the filename of 
the last saved document. You may use this filename or enter a replacement name in the 
Selection box. If the filename you selected already exists, you must verify the overwriting of 
the previous file. If Save Document with Backup is selected in Miscellaneous Settings in the 
Options menu, the previous file will be renamed with a BAK extension. 



Save All Documents
This method is the fastest way to save open documents before exiting. You may also use it 
to save all current changes before continuing work. All documents will be saved with their 
current filenames. If a new document has not been previously saved, the file selector will 
prompt you to enter a filename for it. If automatic saving is chosen in Miscellaneous Settings
(Options menu), all documents will be saved at the specified interval; backup copies will be 
created if Save Document with Backup is selected.



Close Document
This menu item is only available when a document is open. When you select this menu item 
a dialog box appears. You can choose to Save the document, Abandon it, or Cancel the 
command and keep working. Be careful before you click the Abandon button; any work that 
has not been saved will be lost.

A document can also be closed by doubleclicking the Control menu box located at the topleft
corner of the active window.



File Menu - Modules
This menu item allows you to load, delete or replace Calamus modules in the Modules 
selector box:

With the exception of the Clipboard module, any module can be deleted from memory. You 
can also select a module and replace it with another.

You can also Execute some modules directly from the Modules dialog box. Select a module's 
name and click the Execute button. The selected module's icon will be highlighted in the 
Module Row and its last accessed command group will be displayed. 

Some modules are transparent. This means that they work in the background but do not 
have an icon in the Module Row. The Color Settings, Document Converter and Font Load 
modules are examples of transparent modules. Such modules cannot be executed from the 
Modules dialog box.



Import
Calamus uses four types of frame into which you may import data from other sources. These
frames hold text, raster graphics (bitmapped images), vector graphics, and modulespecific 
information (uniframes).

Imported data is normally saved in a proprietary format used by the source program. In 
order to translate data into Calamus format, an import driver is required. Calamus has 
drivers to import data from most wordprocessing and graphic applications. See Appendix H 
for a list of currently support file formats.

To import data into Calamus, you must activate a frame (text, raster graphic or vector 
graphic), then click Import in the File menu. The Import Object Selector will appear. Click the 
Load button and the File Selector will appear with the appropriate file mask: 

C?T for Text drivers 
C?R for Raster graphic drivers 
C?V for Vector graphic drivers 

Select the driver you need and click OK. You will be returned to the Import Object Selector. 
Select the driver name and then click the Import button. 

The File Selector will appear showing filenames with the extension for the respective file 
type. Select the file to be imported and click OK. 

When importing text files, some formatting changes may take place. For example, ASCII files
must be converted during import. A dialog box will appear when importing an ASCII file: You 
will also be prompted to select a font when importing text from any format. The Choose Font
dialog box appears immediately after you have selected the file to be imported. 

Imported text will be formatted in the text frame in the font and font size currently selected 
in the Text Style module. It is not possible to import text if you have not loaded a font. 



Print Document
This menu item allows you to print a document with several options. Calamus will use any 
printer that has been installed using the Print Manager. Refer to the Windows manual 
regarding the installation of printer drivers. Click Print Document to access the Printer 
Settings dialog box. For information on printing options, refer to Printer Settings, chapter 3.



Save Document
This menu item saves the current document to disk using the name with which it was loaded
or last saved. When saving a new document for the first time, Calamus calls the file selector 
for you to enter a filename in the Selection box.

If you have selected the Save Document with Backup option in the Miscellaneous Settings 
function (Options menu), Calamus will change the extension of the previous version of the 
file to BAK and save the current document with a CDK extension. 

You may also choose to have your document saved automatically at specified intervals. See 
Miscellaneous Settings in the Options section of this chapter. 



Export
Calamus can export data to other formats. The export function works the same as the import
function. To export data from a frame, first select the frame, then click Export in the File 
menu. The respective Export Object Selector will appear depending on the type of frame you
have selected.

Calamus can export text, raster graphics (bitmapped), and vector graphics. See Appendix H 
for a list of currentlysupported file formats.

Select the format for export and click the Export button in the Export dialog box. A file 
selector will appear for you to enter a filename. When exporting text as ASCII, a dialog box 
will appear for you to make the appropriate selections. 



Exit
Click this menu item to exit Calamus. If you have a document open, you will be prompted to 
Save or Abandon it. 

If several documents are open, they will all be saved if you choose Save. If any of the 
documents is new and has not been named, you will be prompted to name it. To exit without
saving the open documents, click the Abandon button. To continue working, click the Cancel 
button. 



Options Menu
This menu contains various settings and commands which apply to the entire program 
rather than to a particular module. Most of the options in this menu can be saved to the 
CALAMUS.SET file as system defaults. 

Help Messages 
Copy Options 
Drag and Drop 
Statistics 
Reformat Document 
Document Parameters 
Key Bindings 
Macro Recorder 
Set System Paths 
Miscellaneous Settings 
Select All 



Copy Options

This function allows you to choose various copy options. When you click the menu item, a 
dialog box will appear. 

There are four options: select Physical or Virtual copies for all copies; select copy type each 
time you make a copy; or select Retain Copy Status (make physical copies of physical 
frames and virtual copies of virtual frames). The concept of physical and virtual copies is 
explained in Copy Frame in the Frame Module, chapter 5. 

To make multiple copies of a frame, enter the required number of copies in the Number of 
Copies field. To have copies offset from the original, enter an offset distance in the Horiz. 
Offset and Vert. Offset fields. A positive or negative value in the horizontal offset field will 
place the copy to the right or left, respectively, of the original frame. A positive or negative 
value in the vertical offset field will place the copy below or above, respectively, of the 
original frame. Values in both fields will offset the copy diagonally. To change the unit of 
measure in the offset fields, see Set Units of Measure in the Page Module, chapter 5. 



Drag and Drop
This feature allows you to drag selected text to another position in the text frame. This is 
handy when moving or rearranging words or a sentence within a paragraph. You may also 
save text style and text ruler information when dragging and dropping text.



Statistics

You may obtain a status report on the current document by selecting the Statistics menu 
item. 

The dialog box which appears provides information about the duration of the current work 
session, the total number of pages and the last page used, the number of users who 
currently have access to the document, the available memory and virtual memory, and the 
percentage of RAM used.



Reformat Document
Calamus supports semiautomatic management of footnotes, indexes and page numbers. 
Semiautomatic means that once you have changed text formatting, you must tell Calamus 
to recalculate the numbers. This system speeds up working with text because Calamus does 
not have to calculate every footnote, index entry and chapter/page number every time you 
change text in a document. When you click the Reformat Document, a dialog box below will 
appear.

In addition to the items mentioned above, you can recalculate time and date references. 
Click the buttons on the left side of the dialog box to select the items to be recalculated. 
Finally, the bottom line allows you to specify the page range to be recalculated. For 
information on creating, editing and numbering footnotes, see the respective sections in the 
Frame and Text modules, chapter 5. 

When you reformat a document, Calamus will place a series of footnote numbers in the text 
frames to replace the footnote number placeholders that were inserted when the original 
footnote was entered.    The Numbering Type field indicates which numbering style will be 
used for the footnotes.

When you reformat a document, the contents of existing footnote frames should be deleted. 
Only when you are assembling endnotes from several documents, should you append new 
footnotes to previous ones.

You can also select whether there should be one footnote in each footnote frame, or whether
Calamus should enter footnotes in each frame until it is full. More information about these 



choices is found in the Text Module, chapter 5. 

For information on creating, editing and numbering index entries, see the respective 
sections in the Frame and Text modules, chapter 5. To reformat the index entries in a 
document, click the Index button. 

When you reformat a document, index entries may be sorted in Chronological (in the text 
chain) or Alphabetical order. 

Delete Old will remove the existing contents of an index frame, while Add New will append 
index entries to existing ones. 

If Calamus had to calculate page and chapter numbers every time you inserted a new one, it
would also have to take the time to reformat adjoining text. Instead, the Reformat Document
function can be used to recalculate page and chapter numbers when you wish.

Time and Date references operate in the same manner. The time and date will be inserted 
based on your computer's system clock. When you reformat your document, each time and 
date control code will be updated with the current time and date.

The page number fields allow you to specify the range of pages to be reformatted. By 
default, the first page field contains the number 1. You may enter a different starting page. 
In the second field, you should enter the number of the last page you want to format. 



Document Parameters
This function will generally be used by more advanced Calamus owners. However, even if 
you are just beginning, it is useful to become acquainted with this function. Click the menu 
item and the Set Document Parameters dialog box will appear: 

There are four sets of options in this function: the first two handle text formatting and 
unused document elements; two other options have specific purposes described below. 

Calamus holds text formatting information in RAM while you are working on a document. The
contents of memory are emptied when Calamus needs the memory for something else. 
Calamus does not save text formatting instructions with each file. Instead, every time you 
load a document, the program calculates text formatting as it draws each frame. Most of the
time, this is what you want to happen. 

However, there are exceptions: if you are sending a document to an imagesetter, and the 
printer has a newer version of one of the fonts required, there could be problems. For 
example, some of the characters in the new version of the font might be narrower or wider 
than yours, causing a slight formatting change. You can avoid this problem and save the 
document with its current text formatting by clicking the Lock button. All linebreaks will be 
encoded in the saved file, and Calamus will not calculate them when it reloads the 
document. This way you can be certain your document will be output exactly as it appears 
on your screen.

On the other hand, if you want to reformat all text frames in a document before printing, 
select the Unlock button. Calamus will discard all linebreak information before it saves the 
file. In this case, printing the document will take a little longer because text formatting must 
be recalculated. The No Change button is the default. All linebreak information already 
calculated will be saved, while information for unformatted pages will be calculated when 



printing. 

As you build a document, many different elements may be loaded or created. The Set 
Document Parameters dialog box allows you to delete unused elements when you save your 
document. This will save storage space. You can decide to Keep or Delete unused fonts, text 
styles, master pages, colors, color planes and pages by clicking the respective buttons. 

Prompt When Saving will prompt you each time you save your document. This allows you to 
check settings and change them if desired. It is recommended that you select Yes. 

You can set a Minimum Line Weight for all lines in a document. This option allows you to 
make hairlines heavier; otherwise, they would be only slightly wider than 3/1000 at 2540 
dpi. 

Clicking the Use button will immediately delete the elements for which Unused is selected, 
and return you to the document window to continue work. This function will also recalculate 
all linebreaks and color distribution. 



Key Bindings

Most Calamus functions can be accessed via the mouse or a combination of keys, called a 
key binding. If a key binding exists for a function, the related keys will appear in the Toolbar 
to the right of the page number indicator.    When you click Key Bindings in the Options 
menu, the Key Bindings dialog box appears. A key binding has three parts: special keys, a 
hot key, and a function name.

On the far left side are the special keys: C is for [Control], A for [Alternate], LS for left [Shift] 
and RS for right [Shift]. The middle column shows the hot key used with a special key to call 
a function. The # symbol in front of a hot key means it is found on the Numeric Keypad 
[Number Lock on]. On the right is the descriptive function name. For example, A    N    Create 
new document. means that if you type N while pressing the [Alt] key, Calamus will create a 
new document, as if you had used the File pulldown menu.

There is one exception: a combination such as A LS RS  S Style, means that if you 
press the left or right [Shift] key and the [Alternate] key together with S, Calamus will switch 
to the Style module; you don't have to hold down both shift keys. 

Key Bindings - Defined 

To remove a key binding from memory, select it and click the Delete button. To delete all key
bindings, click Delete All. The key binding(s) can be restored by reloading the current 
keyboard file.



You can load or save a group of key bindings. When you click Load, you are alerted that the 
current key bindings will be replaced. When you choose Save, the file selector appears; 
select CALAMUS.CKT and click OK to save your key bindings.

Key Binding - Examples 

Two key binding conventions should be noted: the # precedes keys found on the Numeric 
Keypad; [Shift] refers to the Left Shift key.

Key Bindings in Use 

Macro recordings can be saved in the CALAMUS.CKT key bindings file for use in later work 
sessions. See additional information see Macro Recorder in Menus, chapter 2.



Macro Recorder
The Macro Recorder allows you to record a sequence of mouse and keyboard actions and 
save it as a key binding. You will then be able to repeat the entire sequence with a single 
keystroke. There is one exception, however. While you can record mouse clicks on icons or 
menu items, you cannot record mouse clicks in the document window. 

To start the recorder, click the Macro Recorder menu item. A checkmark will appear beside 
the menu item to show that the recorder is active.

Calamus will now record all your keystrokes and mouse clicks (except those in the document
window). Click the menu item again to finish recording. At this point the Define Key Binding 
dialog box will appear (see Key Bindings, above). If you choose a key binding which exists, 
the Key Binding Already Used alert box will appear:

You may Replace the existing key binding or select a New Key binding. The [Cancel] button 
allows you to cancel the function. When you have defined a key binding, you may save it 
with the other key bindings in the CALAMUS.CKT file. See the information in Key Bindings, 
above. The key binding you defined will be active for the rest of the current session and will 
be automatically activated when you launch Calamus. 



Set System Paths

Calamus uses a number of proprietary file formats which may be stored in their own 
subdirectory. Set Systems Paths lets you establish the paths Calamus will use to load and 
save the various file types, or the path which the Calamus file selector will use as a starting 
point when searching for a file type. 

In the case of the Fonts path, Calamus will search all subdirectories to an infinite level if you 
have selected the Relative option for System Paths in the System Parameters module.

To set a search path, click the appropriate file type on the left side of the dialog box. When 
the file selector appears, you can move through different subdirectories. When you reach 
the subdirectory containing the particular file type, click OK to enter the name of the current
subdirectory in the pathname list. 

When you have set your System Paths, save the information for future sessions by using 
Save System Setup in the Options menu. 



Key Binding - Examples
Here are some examples of key bindings:

[Alt] F Press Alternate and type F key
[Ctrl] O Press Control and type O key
[Shift] 2 Press Left Shift and type 2 key
[Shift][Control] M Press Left Shift and Control and type M
[Right Shift]#6 Press Right Shift and type 6 on the numeric keypad

The [Alt], [Ctrl], [Left Shift] and [Right Shift] keys are called special keys. Pressing a special 
key by itself has no effect. To create a key binding, a special key is combined with a hot key. 
In the examples above, F, O, M and #6 are the hot keys.

Key bindings may be composed of a single special key and a hot key; they may also combine
two or more special keys with a hot key, e.g. [Alt][Shift] L, or [Alt][Ctrl] U. However, there 
can be only one hot key in a key binding. 



Key Bindings in Use
Now that key bindings have been defined, let us examine their uses within Calamus: 

1) as keyboard equivalents for a mouse click on an icon
2) for entering special text characters and control codes
3) to execute a recorded task

Some examples of key bindings used as keyboard equivalents include [Alt] F for pulling 
down the File menu; [Alt] S for Save Document; and [Alt] P for calling the Printer Settings 
dialog box. Many of the frequentlyused command icons have a keyboard equivalent.

Key bindings are also used to create special text characters or control codes. The Key 
Bindings Editor dialog box lets you assign keys to enter hyphens, variable fixed spaces, line 
ends and quotation marks. Key bindings can also be assigned to a few miscellaneous 
functions.

Finally, key bindings can be assigned to any task that has been programmed by using the 
Macro Recorder in the Options menu. When the respective key binding is used, the recorded 
task is executed. For example, a macro is recorded that will send text from the text editor to 
a selected text frame and replace the existing text in the frame; then save the document. A 
key binding, e.g. [Alt][Shift] S, is then assigned to execute the task. You now have a macro 
that makes it possible to save a document without leaving the text editor.



Key Bindings - Defined
The Define Key Binding function lets you change the keys used in a key binding. Doubleclick 
on the left side of a key binding entry and the Define Key Binding dialog box will appear: 

Click the buttons for the keys you wish to use for the key binding. If the key binding is 
already in use, this alert will appear:

You can also modify the name of a key binding. Select the key binding and doubleclick the 
right side of the line. A text edit field will pop up and you can enter new text to describe the 
function. This option is useful when using the Macro Recorder to create shortcuts. 



Miscellaneous Settings
When you click this menu item, a dialog box will appear, allowing you to set certain 
parameters:

First, you can decide whether Calamus should keep a backup copy when it saves a 
document. It is advisable to select Yes for this option as it is prudent to backup your files. 

Calamus can automatically save a document to disk at 60, 30, 15, 5 or one minute intervals.
Automatic saves operate once you have named a document and saved it manually the first 
time. To use this function, it would be wise to name and save a document as soon as you 
create it. 

You can decide whether Calamus will show Warning and Alert messages. It is fairly safe to 
shut off Alert messages if you understand the program, but only advanced users should 
consider shutting off Warning messages. For example, when you want to exit Calamus, a 
warning box gives you the chance to save your document. 

The last three buttons in this dialog box are useful if you have a full page monitor. This 
feature allows alerts and dialog boxes to appear at the topleft of the screen near the menus 
and icons, in the center of the screen, or at the pointer position.



Save System Setup
This menu item allows you to save any or all of the current Calamus settings. The settings 
will be saved in the CALAMUS.SET file.    The settings are divided into 14 groups which can be
saved individually. The groups are: 

Printer: settings in the Printer Settings dialog box. 
Modules: settings in the Modules dialog box. 
Paths: paths selected in the Set System Paths dialog box. 
Fonts: currently loaded fonts. 
Key Bindings: key bindings used in Calamus.
Frame Editor: the currentlyselected frame type in the Frame module, snap and display 
options, rotation angle, fixed elements and copy type; in short, all settings in the Frame 
module. 
Miscellaneous: values in the Miscellaneous Settings dialog box, as well as settings for Help 
messages, userdefined viewing size and other values. 
Page Format: settings in the Set Page Format dialog box. 
Colors: current color list. 
Text Macros: the text macro list in the Text module.
Hyphenation: hyphenation parameters defined in the Text module. 
Text Ruler: text ruler settings in the Text module. 
Text Styles: current text style settings, the text style list and the text size in the Text Style 
module.
Lines/Rasters: current settings in the Line and Raster Area modules. 

Click a button to select or deselect a group of settings. The All button will select all groups, 
while None will deselect all groups. The Save button will save the selected settings to the 
CALAMUS.SET file which will be used the next time you load the program. 



Select All
This command will behave differently depending on which module you are using. In the Text 
module, this function will select all text in the current text chain. You can, for example, use 
this command to convert all text to the same font. In the Frame module, Select All will select
every frame on the current page. If, for example, one or more vector graphic frames has 
been selected, this feature will select all vector graphic frames. In the Vector Editor module, 
this function will select all vector objects.

Select All works in other modules too. See the appropriate module documentation for 
specific information. 



Edit Menu
The Edit menu contains the standard Windows functions to Cut, Copy and Paste text, 
bitmaps and vector graphics between Windows applications. These functions use the 
standard Windows clipboard and the special Calamus Windows Clipboard (WINCLIP.CXM) 
module. To ensure the availability of these functions, Save System Setup with the Windows 
Clipboard module installed. 

Edit Menu - Cut 
Edit Menu - Copy 
Edit Menu - Paste 

The above features are particularly useful when, for example, a screenshot is required. Using
these functions, you can snap the screen or even a specific dialog box by using the [Alt] 
Print Screen combination. Then, after creating a raster graphic frame, you can Paste the 
screenshot onto the page without leaving Calamus.

Edit Menu - Clipboard Viewer 



Edit Menu - Cut
This function will cut the contents of a frame to the Windows clipboard so that it can be 
pasted into another Windows application. Text, bitmaps and vector graphics may be cut. For 
additional information, see your Windows manual. 



Edit Menu - Copy
This function will copy the contents of a frame to the Windows clipboard so that it can be 
pasted into another Windows application. Text, bitmaps and vector graphics may be copied. 
For additional information, see your Windows manual. 



Edit Menu - Paste
This function will paste the contents of the Windows clipboard into a selected frame if the 
frame type is compatible with the clipboard data (text for text frames, etc.). For additional 
information, see your Windows manual. 



Edit Menu - Clipboard Viewer
This function takes you directly to the Windows NT ClipBook Viewer and allows you to view 
the contents of the Windows clipboard. It is composed of the Local ClipBook and the 
Clipboard. The Local ClipBook opens when you enter this function while the Clipboard 
window is minimized to an icon. Clipboard contents may be viewed or permanently copied to
the ClipBook. For additional information see your Windows manual and the Windows 
Clipboard Module, chapter 5.



Help Messages
In the Status Line that appears in the bottomleft corner of the screen, Calamus will display 
the name of a function or menu item as the pointer passes over the related icon or menu 
entry. Click Help Messages to toggle these messages on or off. A checkmark beside this 
menu item means that help messages will be displayed. 

Whenever the cursor rests on an icon, a Tool Tip will also popup to show its name. You may 
disable Tool Tips in the System Parameters module. 



Window Menu
The Window menu contains standard elements of the Windows environment. The Window 
menu has three areas: Display, Palettes and Document List. Each area is described in more 
detail below. 

Window Menu - Display 
Window Menu - Palettes 
Window Menu - Document List 



Window Menu - Display
Tile and Cascade determine the manner in which Calamus document windows are displayed.
One would normally work in Cascade mode and select other document windows as needed. 
The Arrange Icons menu item is used by the Program Manager and has no effect inside 
Calamus. 



Window Menu - Palettes
The Module Row, Toolbar, Command Groups and Iconbar are Windows palettes which provide
access to many Calamus functions. Since many of those functions may also be accessed 
through key bindings, you may choose to increase your work space by hiding one or more 
palettes. To do so, click the menu item and the palette will disappear. Click again to restore 
the palette. 



Window Menu - Document List
The Document List will display the names of up to 9 documents. If more than 9 are loaded, 
More Windows will appear at the bottom of the list. Click More Windows to see a list of the 
remaining document names. To activate any document in the list, simply click its name. 



Help Menu
Help menu items operate in the standard manner for a Windows application. For information,
consult your Windows manual or click the How to Use Help menu item.

There are two menu items worthy of extra mention: Contents and Module Help. Each of 
these items provides information to assist in your use of Calamus. 

Help Menu - Contents 
Help Menu - Module Help 

The final items in the Help menu are Product Information and About Calamus. These menu 
items provide information about Calamus, its creators and trademarks.



Help Menu - Contents
The Contents menu item leads to the main Calamus help system. The Calamus Help System 
is organized into specific components for Standard Elements, Menus, Printing, Color, 
Modules and an Index. You can also use the Windows Search function to go directly to a 
topic. The Edit and Bookmark functions will help you to locate information quickly. 



Help Menu - Module Help
The Module Help menu item leads to a popout menu showing a list of modules. Each item in 
the popout menu leads to help on the respective Calamus module. Once you have entered 
the required help area, you can use standard Windows commands to access the information 
you require. 



Printing
Calamus offers many possibilities inherent within its output capabilities. Some of these 
features are specific to a particular output device, while others offer across the board results
regardless of your printer or imagesetter. The following will deal with the myriad options for 
printing in Calamus.

Mount Module 
PostScript Printing 
Printer Driver Modules 
Printer Settings 
Raster Generator Module 
StarScreening Module 



PostScript Printing
Calamus PostScript output is based on the Windows NT printing system. This allows all 
Windows NT PostScript printer drivers to be used to output Calamus documents on a laser 
printer or a PostScript RIP. Calamus can print using any printer installed under Windows NT, 
including monochrome and color printers without PostScript, with and without PDL (Page 
Description Language), etc.

Furthermore, Calamus can output documents through the internal Windows NT PostScript 
printer management system to a PostScript printer or imagesetter, including a color 
PostScript printer. The PostScript output of Calamus also works with the EPS Handler and 
Color Separation modules.

PostScript Printing - Fonts Under PostScript 
PostScript Printing - Rasterization with PostScript 
PostScript Printing - Color Separation Under PostScript 
PostScript Printing - Technical Information 



PostScript Printing - Fonts Under PostScript
Using PostScript output devices raises some questions regarding fonts. If you print a 
document that uses TrueType fonts on a PostScript printer, one of the following methods can 
be used:

1. Windows NT can replace the TrueType font with a reference to a type 1 print font 
which is then downloaded to the printer during the print job (specified from a Type 1 soft 
font directory).

2. The TrueType font is replaced by a Type 1 font already installed in the RIP (Raster 
Image Processor).

3. Windows NT printer management can generate a Type 3 font in memory, which is 
then downloaded to the RIP as part of the print job.

The first two methods are the fastest, but some problems with WYSIWYG can result because 
the TrueType and Type 1 fonts might be different. The third method ensures 100% WYSIWYG 
when using TrueType fonts on a PostScript printer, but it is also the slowest method for 
outputting a document. Furthermore, this method requires a lot of memory if different font 
sizes are used in a document because each variation must be downloaded separately to the 
RIP. 

You can choose between the first two methods in the Printer Settings dialog box under the 
Advanced tab.

This option takes you to the Printer Setup dialog box of Windows NT. The corresponding 
options are only available if a PostScript printer driver is loaded. For more information 
concerning the use of soft fonts and replacement fonts, refer to the appropriate sections of 
the Windows NT manual.

You can also use Calamus SoftRipping with a PostScript device. With this option, the internal 
RIP of the PostScript device is bypassed and all data is processed by Calamus and 
transmitted to the output device as a single image. 

The output method chosen depends on the job, its complexity, the necessity for absolute 
WYSIWYG, etc., and must be defined for each print job by the user. Calamus can use the 
power of the Windows NT network print options, even in conjunction with PostScript output 
devices.

For output to nonPostScript printers in low resolution, fonts are generated as bitmaps by 
Windows NT and then sent in the desired resolution to the printer. For high resolution non-
PostScript printers, Calamus generates the chosen fonts at the selected resolution (from 600
to more than 5000 dpi) and therefore ensures true WYSIWYG.



PostScript Printing - Rasterization with PostScript
When you output a page on a PostScript printer, Calamus uses the screening values for the 
page or the entire document as set in the Raster Generator module. However, you cannot 
use different screen values for individual frames due to the limitations of PostScript.

If there are specific settings for single frames, they are overwritten by the values for the 
page or the document. The parameters of the Raster Generator module have no effect on 
output because the current raster screens are generated by the RIP and not by Calamus. The
Calamus output manager directs the RIP to employ the raster values set by the user. From 
then on, it is the responsibility of the RIP to generate correct rastering. Calamus does not 
raster the current data. Instead, it sends the data as grayscale images to the PostScript 
output device where they are rastered by the RIP. This is also why it is not possible to use 
other Raster Generator functions such as raster point form, bias, and angle when outputting 
to PostScript devices.

If you are using the StarScreening module, the corresponding frames are rastered by the 
module and then sent to the PostScript RIP as bitmap pictures. In this way the builtin raster 
function of the RIP is bypassed. This process behaves similarly with the color separation of 
Calamus pages.



PostScript Printing - Color Separation Under PostScript
To use color separation on a PostScript output device, a few things have to be considered:

1. Raster settings can only be defined for a complete page or an entire document. 
Rastering single frames is not possible due to limitations in PostScript.

 2. The color separation of pictures, vector graphics and text is done by Calamus and 
output on the corresponding color film/plane.

3. CYMK separated TIFF 6.0 images are correctly output to each color plane.

4. A print job is processed as one task consisting of separate pages for each process 
color (CYMK) and each spot color. 

5. EPS data from uniframes cannot be separated if it has not been preseparated. This 
data can be archived with Adobe Separator or a comparable application. For more 
information, see EPS Handler Module, chapter 5.

The setting of control lines, and hence the associated editing of the UCR and GCR curves 
inside the Calamus color separation module, can be used for entire pages and individual 
frames. Only one raster is used.

In the same way, entire Calamus pages or documents can be output to a PostScript file by 
using external media. The color separation of these files can be done with the help of the 
Adobe Separator or comparable application. In general, there is no limitation to the number 
of color planes for PostScript output (CYMK plus spot colors). 



Printer Driver Modules
A number of printer driver modules let you output single or multiple pages to files, instead of
a printing device. In all cases, the printer driver module is loaded through the Modules dialog
box and accessed in the Printer field of the Printer Settings dialog box:

TIFF Module 
BMP Module 
DCS Module 



Raster Generator Module

Rastering is used to achieve high quality graphic output. Appendix B of the manual explains 
some of the problems that can occur when rastering pictures. The Raster Generator module 
provides you with the means to define and assign appropriate rasters to single frames, 
pages or even an entire document.

If the Raster Generator module is saved in your system setup file, it will load when Calamus 
is launched. If it does not load, click Modules in the File menu and load RAST_GEN.CXM in the
Modules dialog box.

The icon for the Raster Generator module is located in the Page Layout command group of 
the Page module. You may also use the Execute button in the Modules dialog box to access 
the Raster Generator module. As with all modules, the Raster Generator module can be 
deleted when not in use. 

Since rastering is a major function which can greatly influence the quality of output, some 
theory is useful before discussing the functions of this module. However, it is impossible 
within a few paragraphs to convey the complexity of the rastering process. For further 
information, please read Rastering Principles.

Rastering Principles 

The Raster Generator module is activated within the Page Layout command group of the 
Page module. When selected, a dialog box will appear, allowing you to specify if you want to 
set the raster for one or more selected frames, the current page, or the entire document. If 
no frame is selected, the frame icon is shown in gray and cannot be activated.

This dialog box is also used to delete raster settings assigned to a frame or page. If no raster
setting has been assigned, the Delete Raster Settings icons will not be selectable. Since a 
raster setting is required to output a document, the raster settings for a document cannot be



deleted. The default raster setting will be applied if you have not set a raster for the 
document or any frames or pages within the document. 

The raster settings for a document are applied first. Settings for individual pages supersede 
settings for a document. Settings for individual frames supersede settings for a page or 
document.

After selecting the Raster Generator, a dialog box will appear. For more information, select 
the appropriate feature in the dialog box.

Raster Generator Dialog Box 



Rastering Principles
The fundamental problem of an output device, be it a laser printer or an imagesetter, is that 
it is impossible to print true grayscale or color gradation. While mixing colored light on the 
screen leads to the creation of a new color, the same is not true on paper.

A different approach has to be taken for printing. We will describe the principle for 
grayscales which, in turn, can be applied to colors. Grayscales cannot be printed without a 
great deal of effort, since for each gray tone, a separate color is required. The only method 
is to simulate the gray value. To achieve this, a weakness of the human eye is used. If dots 
are printed small enough, the human eye does not recognize them as dots, rather they 
become blurred into each other.

If the ratio of surrounding color to print color is changed, the visual impression also changes.
Many small black dots convey the impression of a light gray tone. The same number of 
larger dots results in a darker gray tone.

This is an important concept. Many small black dots on a white background will be seen as 
gray because the eye is unable to discern individual dots as dots; it blurs the dots and the 
white background to a gray tone. The ratio of printed dots to unprinted area determines 
whether a gray tone is darker or lighter.

Halftones 
Line Screens 
Raster Angle 



Halftones
Black and white photographs consist of continuous tones which cannot be reproduced on a 
printing device. These images are known as halftones. As above, dots are used to reproduce 
various shades of gray. The Raster Generator module automatically converts images to 
halftones.

Halftones are broken down into evenly divided groups known as halftone cells. A halftone 
cell is made up of a grid of pixels. A pixel is the smallest unit printable on an output device. 
If you take a magnified look at a halftone cell, the various elements become evident.

The size of a halftone cell determines the number of shades of gray you are able to output. A
5x5 halftone cell, for example, can create 26 shades. The 26 shades are created by printing 
0-25 dots. Therefore, increasing the size of the halftone cell will also increase the number of 
shades available. 

In a 16x16 halftone cell, the maximum number of shades that Calamus can handle is 256. It 
is possible to create halftone cells larger than 16x16, but these cells will not produce 
additional shades, only more complex, larger dots.



Line Screens
The vertical and horizontal distances between dots in halftones is measured in either lines 
per inch (lpi) or lines per centimetre (lpcm). This distance is commonly referred to as the 
Line screen. Line screens should not be confused with the resolution of an ouput device 
which is measured in dots per inch (dpi). Resolution defines the maximum number of points 
per inch which an output device can represent. A halftone using a 133 lpi line screen will be 
much finer and overall a better reproduction than one using 85 lpi.

There are several factors to consider when determining which line screen setting is 
appropriate. Different applications require different line screen settings. For instance, a 
coarse setting of 85 lpi is typically used for newspapers; a medium setting of 133 lpi is used 
for magazines or commercial printing; fine settings of 175 lpi and over are used to produce 
high quality work. 

Another factor to consider is the output device. The typical 300 dpi laser printer will not be 
able to output a 133 lpi screen. The best it can achieve is approximately 70 lpi. A line screen 
of 133 lpi generally requires output devices capable of handling resolutions of 1200 dpi and 
greater. 

The last factors to consider are the printing press itself and the type of material that will be 
used in the printing. Your print operator will be able to provide advice in these areas.

For example, if you are using a 600 dpi laser printer and wish to output using 64 shades of 
gray, the line screen would be 75 lpi.    

600 dpi U \64 = 75 lpi



Raster Angle
Not only does the distance between dots affect the quality of a halftone, the angle of the 
dots is also important. If a raster angle of 0 degrees is used, the dots appear as horizontal 
and vertical lines rather than gray information.

The raster angle is the rotation angle at which a raster has been rotated from the horizontal 
axis. When printing with multiple colors, it is necessary to specify a different raster angle for 
each color to avoid distortion effects such as moiré patterns. When printing work with just 
one color, you should always use a raster angle of 45 degrees.

This field allows you to set the raster angle for the various color planes. As previously stated,
the black color plane should be set to 45 degrees for the best results. When outputting in 
color, the following angles are normally used: Cyan at 15 degrees, Yellow at 0 degrees, 
Magenta at 75 degrees and Black at 45 degrees.

These settings will usually eliminate moiré patterns and produce the best results. However, 
consult your print operator if you have questions regarding raster angles.

Since it is not practical to generate a raster for every possible angle, Calamus will round off 
the raster angle. The actual angle to be used is displayed to the right of the raster angle 
field. The two scroll buttons control the deviation of the angle which consequently changes 
the matrix size of the halftone cell or raster. The smaller you set the deviation, the larger the
matrix size will be; this also increases the amount of memory and computation time 
required. These arrow buttons have no effect on 0 degree, 45 degree and 90 degree angles 
since these angles can accommodate halftone cells in a uniform manner. All other angles will
be affected because the resulting halfone cells will be irregular and cannot be applied to the 
matrix in a uniform manner.



Raster Points/Bias
From the previous discussion, you may have assumed that a point is round. Normally it is, 
but annoying effects can occur when using round dots.

If a raster point increases in size, it will naturally touch neighboring points. When 
neighboring points touch each other, a socalled tone value jump occurs because the gray 
value undergoes a strong change at the point of contact. In a picture, this is not usually 
noticeable. If, on the other hand, you want to incorporate a grayscale into your document, a 
tone value jump can be annoying. As contact is made, the grayscale becomes darker.

It makes sense to experiment with different raster point shapes to achieve the desired 
outcome. The simplest solution is to use triangles or squares instead of round points. As an 
alternative, the original form of the raster point can also be distorted by using a bias 
function. Bias can be used to change round raster points into elliptical shapes, or to stretch 
triangles or squares. Use your eye to determine the best setting.

Round points blend at approximately 65% gray value. Square points blend at 40% gray 
value. Elliptical points are distorted round point shapes; this shape has two blending points: 
one at approximately 50% gray value and another at approximately 75% gray value. This 
has its advantages: the tone value jump that the eye recognizes distributes itself over two 
areas within the grayscale and therefore appears less distracting. Further, the second tonal 
jump at the 75% gray value is located in a dark region and is less perceptible. Tone value 
jumps are more noticeable in light regions.

Tone value jump is also influenced by the raster. A coarse raster will not show a tone value 
jump (caused by touching points) as strongly as a fine raster.

To achieve detail, you should use either round or square points. To get a more even gradient 
with darker gray values, square points should be used because points will touch each other 
at 40%, after which the distribution is even, until black is reached. A square point is only 
square at a 50% gray value. The point is more or less round in the remaining gray areas.

An elliptical point is better suited to fine gradients since the tone value jump is distributed 
across the gradient and is not readily perceptible.



Filter Name
The top field in the dialog box is for the name of the raster setting. Naming a raster setting 
is optional, but it is an effective way to differentiate between various raster settings. The 
Filter Name is different from the filename used when raster settings are saved by using the 
Save command. 



Color Plane
Below the Filter Name is a list of process colors for which you can set a raster. The process 
colors are Cyan, Magenta, Yellow, and Black as well as any spot colors that may be used in 
the document. To access the various colors, use the arrow button to display the dropdown 
list. If you are printing in color, the raster settings should be set for all four color planes. 
Black and white printing only requires the black plane to be set. Using this option lets you 
set the rasters of several color layers while in the Raster Settings dialog box.



Raster Width
This field allows you to set the distance between raster points, also known as line screening. 
Raster width is measured in lines per centimetre or lines per inch. To toggle between 
measurement systems, click on the unit of measure. 

Calamus will round off the raster width for internal use. The actual raster width to be used is 
displayed to the right of the raster width field. The two arrow buttons can be used to change 
the matrix size of the halftone cell or raster which, in turn, changes the round off value of 
the raster width.



Matrix Size
The matrix size represents the size of an individual halftone cell. This field cannot be entered
from the keyboard because it is automatically calculated using the values entered in the 
raster angle, raster width and X and Y resolution fields. As mentioned above, the matrix can 
also be affected by using the arrow buttons associated with the raster width and raster 
angle settings. A word of caution: although increasing the size of a matrix will increase the 
number of shades that can be produced, it also increases the processing power required.

X and Y Resolution 



X and Y Resolution
These two fields are used to enter the horizontal and vertical resolutions of your output 
device or the intended output device. As mentioned, the resolution of an output device 
affects the matrix size.



Raster Shape
The individual dots of a halftone cell can be triangular, round or square. Choose the required 
shape by selecting the appropriate icon. 



Raster Generator Dialog Box
The Raster Generator dialog box contains many features. For a more complete explanation, 
select the appropriate item, below:

Filter Name 
Color Plane 
Raster Angle 
Raster Width 
Matrix Size 
Raster Shape 
Elliptical Bias 
Raster Generator Module - Load and Save 
Raster Generator Module - OK and Cancel 



Elliptical Bias
It is possible to distort the dots that make up a halftone cell. With smaller values, the dots 
slowly transform into linear form in a counterclockwise direction. Larger values cause the 
same behavior, but in a clockwise direction. Entering a value of 1.0 restores the original dot 
shape. 



Raster Generator Module - Load and Save
The Load and Save functions allow you to retrieve and store raster settings for use in other 
documents. Choosing either of these buttons will display the file selector dialog box. The CRI
extension for raster settings is automatically added when you save.

A number of common raster settings are supplied with Calamus. These settings can be 
found in the RASTER subdirectory. If you save a raster file with the name CALAMUS.CRI in 
the directory where the Raster Generator module is located, these settings will become the 
default settings for the Raster Generator module.



Raster Generator Module - OK and Cancel
Click the OK button to assign the current raster settings and exit. An alert will ask you to 
confirm the raster settings.

Click the Cancel button to exit without making changes to the raster settings in your 
document.



Printer Settings
This dialog box, which appears when you select Print, does more than start the printing 
process. It also controls a host of output functions including color separation, page 
orientation, and scaling.

The Printer Settings dialog box is divided into three    areas: Printer Settings, 4 tab dialog 
boxes and the command buttons discussed next.

Printer Settings - Command Buttons 

Printer Settings - Printer 

Printer Settings - Document Tab Dialog Box 
Printer Settings - Options Tab Dialog Box 
Printer Settings - Advanced Tab Dialog Box 
Printer Settings - Color Tab Dialog Box 



Printer Settings - Command Buttons
There are three printer settings command buttons, Print, Mount and OK. For further 
information, select the appropriate option:

Printer Settings - Print 
Printer Settings - Mount 
Printer Settings - OK 



Printer Settings - Print
Clicking the Print button closes the Printer Settings dialog box and begins the output 
process. Calamus will keep you informed about how many frames, pages and color layers 
remain to be output.



Printer Settings - OK
Clicking the OK button allows you to leave the Printer Settings dialog box without starting 
the output process while retaining all the settings you have chosen. Keep this in mind if you 
are working with more than one document at a time.



Printer Settings - Printer
The top section of the Printer Settings dialog box shows the currentlyselected printer along 
with the form (paper/envelope size), the paper tray to be used, the output resolution and 
color depth. These attributes are supplied by printer drivers that you have installed in the 
Windows system. To install a new printer driver, refer to your Windows NT documentation. 
Clicking the arrow beside each field will display the dropdown list associated with each 
printer's settings.

Clicking the Network Printer Browser button will bring up the Windows NT Connect to Printer 
dialog box. For more information    refer to your Windows NT documentation.



Printer Settings - Document Tab Dialog Box
The Document tab dialog box is the first of four tab dialog boxes in which to specify the 
parameters required to output your document. The Document tab dialog box controls the 
number of copies, scaling, the range of pages to be printed and page orientation. 

Printer Settings - Copies 
Printer Settings - Scaling 
Printer Settings - Fit to Page 
Printer Settings - Print Range 
Printer Settings - Orientation 



Printer Settings - Copies
You will usually print one copy of a document, but it is also possible to print multiple copies. 
Simply enter the number of copies of each page you want printed. For additional copy 
options, see Collate Copies in the Options tab dialog box.



Printer Settings - Scaling
The scaling default setting (100%) will output your document at 1:1 ratio. It is possible to 
change the scaling which will allow you to enlarge small originals for readability or shrink 
large originals to fit the paper size.



Printer Settings - Fit to Page
If this option is selected, a scaling factor is calculated which prints pages to the maximum 
printable area on the paper. A printer driver must be loaded. The scaling factor is displayed 
in the Scaling field when you select Fit to Page. This function works in both Portrait and 
Landscape modes. For an imagesetter, the width of the film is used to determine the 
maximum printable area.



Printer Settings - Print Range
The default setting for the page range is All. You may also print selected pages. Click All, 
then click Select to show the current page in the From and To fields; you may edit either 
setting. You may also use Min. or Max. to quickly enter the first or last page, respectively, of 
the document. 



Printer Settings - Orientation
The Orientation option lets you print pages in portrait or landscape mode. The default 
setting is Automatic and it prints pages as they were created in the Set Page Format function
in the Page module. Any elements which do not fit on the printed page, using the selected 
orientation and dimensions, will not be printed.



Printer Settings - Options Tab Dialog Box
The second tab dialog box (Options) controls additional printing parameters:    Sort, Tiling, 
Duplex printing, the use of TrueType fonts and Collate Copies.

Printer Settings - Sort 
Printer Settings - Tiling 
Printer Settings - Duplex Printing 
Printer Settings - TrueType Fonts 
Printer Settings - Collate Copies 



Printer Settings - Sort
Sort - Up/Down

Depending on the application or output device you are using, it is possible to choose 
whether the pages of a document are to be output in ascending or descending order. For 
example, if we assume the printer ejects paper with the printed side up. If you have selected
ascending order, the first page will be at the bottom and the last page on top of the stack. 
Descending order would be a better choice since the printed pages would be stacked in 
reading order. If the printer deposits the paper printedside down, ascending order would 
make more sense.

Pages - Left/Right 

If you are using a facing page layout, alternate pages are designated as left and right. To 
print all pages, both the Left and Right buttons must be selected.

The Left and Right buttons can also be used to print on both sides of the paper: first you 
print all the right sides in ascending order (all front sides), then flip the stack upside down 
and print all left sides in descending order. 



Printer Settings - Tiling
If you have created tiling frames, you can choose whether the Whole page, All Tiles or 
Selected Tiles are to be printed.

If you have set a page border for your document in the Page module, the Whole button will 
print the layout page and the border that contains crop marks, registration marks and the 
name of the color plane. 

The All Tiles button prints only those areas of the document covered by tiling frames.

The Selected Tiles option prints tiling frames that are currently selected. This allows you to 
print one or more selected tiles rather than all the tiles on a particular page or series of 
pages.



Printer Settings - Duplex Printing
Some printers are able to simultaneously print on both sides of the paper. If you have this 
kind of printer, you have to specify how the printer ejects the paper before the second page 
is printed; horizontally or vertically.



Printer Settings - TrueType Fonts
Although the SoftRipping abilities of Calamus remove the need to use PostScript printer 
drivers, there are situations where you wish to output via PostScript, possibly due to the 
nature of your output device. For this reason, you can Substitute the fonts used in your 
document with PostScript fonts, or Download them to the PostScript RIP. If you intend to use 
this option, be aware that Calamus will not have full control over the quality and precision of 
output. Alternatively, you may choose to Render the Calamus fonts into bitmap images that 
are printed as a graphic by the PostScript device. See PostScript Printing further on for more 
information about using TrueType fonts and printing with PostScript.



Printer Settings - Collate Copies
This option is related to the Copies field found in the Document tab dialog box. If you are 
outputting more than one copy of a multiplepage document, it is possible to specify the 
order pages will be printed.



Printer Settings - Advanced Tab Dialog Box
The third tab dialog box, Advanced, controls special functions for film exposure. It also allows
you to activate the Mount module as well as access the Page Layout Settings dialog box. 

Printer Settings - Invert 
Printer Settings - Mirror 
Printer Settings - Layout 
Printer Settings - Mount 
Printer Settings - Pattern 
Printer Settings - Layout Element 
Printer Settings - Using SoftRipping on PostScript Devices 
Printer Settings - Using Generic Window Printer Drivers 



Printer Settings - Invert
Clicking the Invert button will produce negative output. The ability to invert output is 
essential if you want to produce high quality prints. In this process, film is placed on a photo-
sensitive metal plate and then exposed. The exposed areas are etched with an acid. Applied 
color can then accumulate in the depressions and be transferred with a roller onto paper.



Printer Settings - Mirror
Clicking the Mirror button will produce a mirrored image. This is important to produce film, 
for example, for silkscreening. Since this film is exposed on a photosensitive coated screen 
in a contact procedure, it is important that the printed side of the film be closest to the 
screen to avoid underexposure. To produce rightreading, emulsiondown film, both the Invert 
and Mirror options should be selected.



Printer Settings - Layout
Clicking the Layout button will cause Calamus to output the selected layout marks found in 
the page border surrounding a document page. Layout marks may include crop marks, 
registration marks, text labels and color plane information. These marks are selected in the 
Page Layout Settings of the Page module or by clicking the Page Layout button in the 
Options tab dialog box.



Printer Settings - Pattern
Calamus offers three methods to output fill patterns. The one best suited to you depends on 
the output device you are using. The raster fill patterns in Calamus are optimized for a 
resolution of 300 dpi, which corresponds to the resolution of a normal laser or inkjet printer. 
For a 300 dpi printer use the x1 setting. 

If the resolution of your output device is higher than 300 dpi, you have two other 
possibilities. Clicking the xN button will enlarge the pattern by an even multiple. For 
example, you can convert 300 dpi to 2400 dpi in this manner. 

For a resolution that is not a multiple of 300, click the xR button.    The disadvantage of this 
option is that moiré patterns could result.    

Depending on your printing device, select the most compatible of the three options. 



Printer Settings - Layout Elements
This option allows you to access the Page Layout Settings dialog box. See Page Layout 
Settings in the Page Module.



Printer Settings - Using SoftRipping on PostScript Devices
Calamus normally uses its own SoftRip® technology, which means that everything you see 
on the screen is exactly what is output. Therefore, a PostScript printer driver is not required 
to produce high quality output. However, if you output via a PostScript printer driver, 
SoftRipping can be used by selecting the Use SoftRipping on PostScript Devices button. 
When selected, the internal RIP of the output device is disabled so that only Calamus-
rendered raster data is printed. The advantage is that you can be sure that the output is 
what you want. The disadvantage is that large amounts of data have to be transferred.



Printer Settings - Using Generic Window Printer Drivers
It is possible to bypass the SoftRipping capabilities of Calamus by selecting the Use generic 
Windows printer driver button. The printer driver supplied with Windows will be used to 
output the document.



Printer Settings - Color Tab Dialog Box
The final tab dialog box deals with color and settings for color separation. 

Printer Settings - Single Plane or Color Separation 
Printer Settings - Spot Color 
Printer Settings - Knock-Outs    KnockOuts
Printer Settings - Overprint Black 



Printer Settings - Mount
If MOUNT.CXM (Mount module) is loaded, clicking the Mount command button will display 
the Mount module dialog box. 

The Mount module outputs a document in different ways to facilitate collation and binding. 
To activate this module, click the Mount button. If the Mount button is unselectable, the 
Mount module must be loaded via the Modules dialog box. The Mount module dialog box can
also be accessed in the Page module. See Mount Module, for additional information.



Printer Settings - Single Plane or Color Separation
Use this dialog box to output a multicolor document in a Single Plane    (monochrome) or 
Color Separation for any number of color planes. 

On monochrome printers (and imagesetters), the entire document is normally converted to 
grayscale when you select Single Plane. If the Color Separation (CYMK) button is selected, 
the bottom part of the dialog box will display a list of all color planes defined in the 
document. By default, the four process colors (Cyan, Yellow, Magenta and Black) will always 
appear in the list. The list will also show any spot colors that have been defined in the 
document.

You may select individual color planes for printing by clicking the respective color plane 
name. To select all planes, click the All button in the Select Color Planes field. Conversely, 
click None to deselect all color plane names.

The Separate Spot Colors field refers to the color separation of spot colors. See Spot Colors, 
next.



Printer Settings - Spot Color
By definition, spot colors are not colorseparated; they are colors applied with a single pass of
printer's ink. However, it is possible to colorseparate a spot color. This option is useful when 
the print operator does not have the ink for a spot color defined in a document. By using 
color separation, the spot color can be duplicated using the CYMK process colors.

To colorseparate a spot color, click the CYMK box to the left of its name. To deselect color 
separation for a spot color, click the CYMK box a second time. To select color separation for 
all spot colors, click the All button in the Separate Spot Color field. Conversely, click None to 
deselect color separation for all spot colors.



Printer Settings - Knock-Outs
The term knockout refers to a process in which the area underneath a spot color is left 
unprinted by other colors. This ensures that the spot color will appear the same in all areas 
of a document. The opposite of a knockout is overprint. In overprinting, a spot color is 
printed on top of underlying colors. This can cause inconsistent appearance of the spot color
because of the variations of underlying colors. 

In the color separation list, a boxing glove icon symbolizes the knockout function. The boxing
glove icon appears to the right of each color name. An X over the boxing glove icon indicates
that the knockout option is disabled for the respective color plane.

The knockout option is automatically disabled for process colors (CYMK) and for any spot 
color for which color separation is selected.

By default, all unseparated spot colors have the knockout option selected. To deselect the 
knockout option and cause a spot color to be overprinted, click the boxing glove icon; it will 
disappear. Click again to restore knockout.



Printer Settings - Overprint Black
When Overprint Black is selected, black will be printed on all process and spot colors. The 
density of the black will be greater because of the underlying colors. However, one should 
be aware that black overprinting may increase ink weight beyond the normal threshold of 
225 to 250%, thus affecting inkdrying and related conditions.



Mount Module

The Mount module is a document manager which allows you to print the pages of a 
document in ways that facilitate collation and binding.

To load the Mount module, click Module in the File menu. When the Modules dialog box 
appears, click Load and then choose MOUNT.CXM in the MODULES subdirectory. To load the 
Mount module automatically when Calamus is launched, use Save System Setup in the 
Options menu. As with all modules, the Mount module can be deleted when not in use or 
when memory is limited. 

The Mount module icon appears in the Page module, not in the Module Row. The Mount 
module can also be accessed by clicking the Mount button in the Printer Settings dialog box:

Mount Module - Overview of Features 



Mount Module - Overview of Features
The Mount module dialog box will appear when you click the Mount module icon in the Page 
Layout command group or select the Mount button in the Printer Settings dialog box.

The choices for printing are controlled by the size of paper and the format selected in the 
Mount dialog box. Printing may be done consecutively, book style or magazine style. Mount 
can also be used to print multiple copies on various paper sizes.

Users with lettersize printers can use the doublesized paper option when documents are 
created in Halfpage format. Users with A3 printers can use both the doublesized and 
quadruplesized features when using A4 and A5 page formats, respectively. 

When printing multiple copies of a document, the Mount module will impose as many copies 
of the pages that will fit on a sheet of paper. This option is explained below.

Mount Module - Double and Quadruple Options 
Mount Module - Single Pages on Double-Sized Paper 
Mount Module - Multiple Copies on Double-Sized Paper 
Mount Module - Single Pages on Quadruple-Sized Paper 
Mount Module - Multiple Copies on Quadruple-Sized Paper 



Double and Quadruple Options
These options are automatically set by the Mount module. If your page size is half the paper 
size shown in the Printer Settings dialog box, the Mount module will print two pages per 
sheet of paper. 

If the document page size is onequarter the size of the paper size shown in the Printer 
Settings dialog box, the Mount module will print four pages per sheet of paper.

The following page layout combinations are available within the Mount module: 

Page Size Paper Size       Option  

Half  Letter  Double

A5  A4  Double

A4  A3  Double

A5  A3  Quadruple



Consecutive Option
In the Consecutive option, Mount will print each page of a document in consecutive order. 
For example, in an 8page document, pages 1 and 2 will print on sheet #1, pages 3 and 4 will
print on sheet #2, pages 5 and 6 will print on sheet #3, pages 7 and 8 will print on sheet 
#4. 



Book Style
In the Book Style option, Mount will print pages in sets of four. The first set of pages printed 
will be pages 1 and 4, 2 and 3. The second set will be pages 5 and 8, 6 and 7; the third set 
will be 9 and 12, 10 and 11; and so forth. In each set of four pages, the printed pairs of 
pages are meant to be printed backtoback. When folded, each set of four pages contains 
four consecutive pages. Folded sets of four pages could then be collated and bound.



Magazine Style
In the Magazine Style option, Mount will print the first and last pages together, then the 
second and second last, third and third last, etc. This option works well when creating 
booklets or magazines. As described in the Book Style option above, printed pairs of pages 
are meant to be printed backtoback. These sets of four pages could then be collated and 
bound in a magazinestyle format.



Multiple Copies on Double-Sized Paper
If you enter 2 or more in the Copies field of the Printer Settings dialog box, the Mount 
module will print the required copies, two per page. 



Single Pages on Quadruple-Sized Paper
The quadruplesized option can only be used with an A3 page size and an A5 paper size. 
Therefore, you must have a printer driver and printer that will accept an A5 page to use this 
option. If you are printing Single Pages, Mount will print them in consecutive order, four to a 
page.



Multiple Copies on Quadruple-Sized Paper
If you are printing multiple copies of each page, Mount will print the required number of 
copies on each page and then use the remaining space to print the next page of the 
document.



Single Pages on Double-Sized Paper
When printing singles pages on doublesized paper, you may select from three Mount 
options: Consecutive, Book or Magazine Style.

Mount Module - Consecutive Option 
Mount Module - Book Style 
Mount Module - Magazine Style 

The Mount module computes page arrangement semiautomatically. If the total number of 
pages is not a multiple of four, the Mount module will create blank pages to ensure proper 
sequence. Note the following patterns:

A (4, 8, 12...) page document will be mounted and printed with no blank pages.

A (7, 11, 15...) page document will have one blank page added at the end to partner page 1.

A (6, 10, 14...) page document will have no blank pages added, but will result in a blank 
center section.

A (5, 9, 13...) page document will have one blank page added at the end to partner page 1 
and will also have a blank center section.



Technical Information
To output raster data, Windows NT output is bypassed and the commands are transferred 
directly to the RIP. The Print function handles the entire task when you select Use 
SoftRipping On PostScript Devices in the Printer Settings dialog box. Of course, a PostScript 
printer driver must be loaded.

Since PostScript output runs under the output routines of Windows NT, all Windows NT print 
features will be available including Network Printing and spooling to the Print Queue.



TIFF Module
The TIFF module will create a TIFF file in 1bit monochrome, 8-bit grayscale, 24bit RGB or 32-
bit CYMK format. This module can also be used for creating color separations in 1bit mode. 
One file will be created for each color plane (process and spot colors). Resolutions range 
from 50 dpi to 2540 dpi.



BMP Module
The BMP module will output pages at resolutions between 50 and 600 dpi in monochrome, 
grayscale and True Color modes. Specify the pages to be printed and click OK. The file 
selector will appear for you to enter a filename for each page before printing begins.



DCS Module
The Desktop Color Separator module will create a DCS file containing four highresolution 
TIFF files, one for each color plane (CYMK). Resolutions range from 150 dpi to 2400 dpi. The 
resulting image may be loaded into any application supporting the DCS file format.



StarScreening Module

The StarScreening module applies a new technology to the rasterization process. In 
conventional rastering techniques, raster points are arranged in cells. The more points in a 
cell, the greater the possible number of gray levels or halftones; the more gray levels, the 
smoother the tonal transitions.

StarScreening - Printing Resolution 
StarScreening - FM Screening 

StarScreening makes it possible to achieve high resolution output together with smooth 
tonal transitions without having to use a high resolution output device such as an 
imagesetter. On the other hand, imagesetter output of starscreened frames is exceptionally 
sharp and approaches the quality of continuous tones found in photographs.

For color work, FM screens for each color plane can be overlaid without the special angles 
required in traditional rastering methods. Misregistration is less critical in StarScreening 
because smaller dots are more forgiving. Smaller dots also provide better handling of detail 
due to the dither methods found in FM screening.

On the other hand, the FM process used in StarScreening requires greater care with the print
media because the printed dots are so small. Dot gain and dust on plates are more 
noticeable. Blankets must be kept clean to avoid doubling and ghosting errors. Bureaus that 
are used to working at 200 lpi and higher should have no problem in dealing with FM output.

This version of the StarScreening module will create frames up to 750 dpi. There are two 
command groups that contain parameters for generating and converting starscreened 
frames.

StarScreening Module - Image Parameters Command Group 
StarScreening Module - Raster Parameters Command Group 
StarScreening Module - Technical Information 



StarScreening Module - Image Parameters Command 
Group
The first command group lets you select the color plane to be starscreened. You can also set 
the size of the dots and/or the screening resolution. 

StarScreening - Select Planes 
StarScreening - Set Dot Size 
StarScreening - Set Resolution 
StarScreening - Create Plane 
StarScreening - Check Resolution 
StarScreening - Settings 



StarScreening Module - Raster Parameters Command 
Group
The second command group provides format options for generating a starscreened frame.

StarScreening - Fixed Point 
StarScreening - Random Point 
StarScreening - Minimum Drop 
StarScreening - Maximum Drop 
StarScreening - Create Bitmap Frame 
StarScreening - Create CYMK Uniframe 
StarScreening - Show StarScreened Preview 
StarScreening - No Control Line 
StarScreening - Use Black Control Line 
StarScreening - Use Color Separation Control Line 
StarScreening - Printing 
StarScreening - Control Line 
StarScreening - Delete Module 



StarScreening Module - Technical Information
The basic function of the StarScreening module is the conversion of a frame with varying 
intensities (grayscale) to a onebit per pixel (monochrome) image. In essence, the tonal 
transitions within an image are rendered, in color or black and white, to a set of single pixels.
This is accomplished by the use of special algorithms.

How does this work? In its simplest form, an algorithm would convert an intensity value of 
50% or more to a white pixel; less than 50% would become a black pixel. However, if this 
was the only algorithm in use, the resulting image would have very coarse tonal transitions; 
the image would be of low resolution.

The StarScreening module uses multiple algorithms to convert tones to single pixels in a 
unique way. For example, if an intensity value of 60% is encountered, a white pixel is 
created. However, since the intensity value was not 100% white, there is an error value of 
40%. The error value is subsequently subtracted from the surrounding pixels to compensate 
for the error value. The use of algorithms for error correction is the fundamental principle 
behind starscreening technology. The use of different algorithms is what distinguishes one 
starscreening technology from another.

In the example above, intensity values were expressed in percentages. In fact, intensity 
values are scaled within a range of 0 to 255, resulting in 256 gray levels. We also refer to 
this as an 8bit (256) grayscale. A 50% intensity has a grayscale value of 128. As the 
midpoint value, 128 is also the conversion point. Therefore, intensity values of 128 or more 
are converted to white; 0 to 127 are converted to black. The StarScreening module then 
converts the surrounding pixels by using the error correction method described above.

Within the StarScreening module there are two options for setting algorithms: Fixed Point 
and Random Point. When the Fixed Point icon is selected, the 50% intensity value (128 gray 
level value) is used as the conversion point. All intensity values of 50% or more are 
converted to white; 0 to 50% are converted to black.

When the Random Point icon is selected, the base conversion point is a gray level value of 
110, not the 128 value used in the Fixed Point function. The Minimum and Maximum Drop 
values of 0 and 36, respectively, are then added to the 110 conversion point, creating a 
range of conversion points from 110 (110+0) to 146 (110+36).    Within this range, the 
StarScreening module randomly selects its conversion points.    (You may notice that the 
values range +/- 18 from the midpoint value of 128. In percentages, this range is +/- 7 % 
from the 50% midpoint intensity value.)

By definition, the Fixed Point option will create starscreened frames with identical rastering 
patterns because the conversion point is fixed at the 50% intensity value. When 
starscreening identical images, the Fixed Point option will guarantee identical output. On the
other hand, the Random Point function, by virtue of its random selection of conversion points
within a specified range, will not produce identical output from identical images.



Printing Resolution
Printing resolution (line screening) is designated according to printed lines per inch (lpi) 
where a line is a row of cells. In high resolutions of 85 lpi or more, each cell may have a 
small number of dots which limits the number of gray levels and makes tonal transitions 
coarse. In lower resolutions of less than 85 lpi, there may be more dots per cell thus 
generating a high number of gray levels which creates smoother tonal transitions. To 
achieve both a high resolution (85+ lpi) and smooth tonal transitions, the output device 
must be capable of 1200 dots per inch or greater.



FM Screening
StarScreening uses a different rasterization process called frequency modulated (FM) 
screening. The individual raster points are composed of dots definable in any size beginning 
at 10 microns. The raster points are not arranged in cells, but in special patterns that 
accurately simulate gray levels. 



Select Planes
C,Y,M and K are the four process color planes. Click the icon for the color plane you wish to 
starscreen. Click the centre icon to generate a CYMK StarScreened uniframe. After making 
your selection, click the Create Plane icon to activate the starscreening process.



Set Dot Size
Click the number field and enter the dot size to be used for starscreening. The Set 
Resolution input fields will be recalculated. 



Set Resolution
The horizontal and vertical resolutions in dots per inch will be displayed in the respective 
number fields when you enter a dot size. Alternatively, you may enter a desired resolution in
these fields; in this case, the dot size will be automatically calculated and displayed in the 
Dot Size number field. Setting a resolution to match the output of the printer is the more 
effective way of using the Set Dot Size and Set Resolution functions. 



Create Plane

Click the Create Plane icon to starscreen the selected frame. A starscreened frame will be 
generated on top of the original frame. Move the starscreened frame to view it. The 
starscreened frame will probably have a foggy appearance due to the rasterization method 
used for video display. Output will be much clearer. 



Check Resolution

Select a frame and click the Check Resolution icon to display the current horizontal and 
vertical resolutions in the Set Resolution number fields. The Dot Size will be displayed as 
well. This function may be used to check a starscreened frame, or a regular frame.



Settings

Click the information icon to display the StarScreening Settings dialog box, shown at right. 
Delete Original Frames will delete the source frame after the starscreened frame is created. 
Sound Upon Completion will produce a warning tone when starscreening is finished.



Fixed Point

When this icon is selected, fixed points will be used to generate a starscreened frame. This 
function may be used for achieving special mosaic effects at low resolutions. In general, the 
Random Point option is best for starscreening.



Random Point

When this icon is selected, random points will be used to generate a starscreened frame. 
This function should be selected for most starscreening conversions. 



Minimum Drop
A value of zero is the recommended setting for the Minimum Drop parameter. This function 
is the lower limit of the random point dropoff range. Changing the value in this field will 
change the tonal values of the starscreened image.



Maximum Drop
A value of 36 is the recommended setting for the Maximum Drop parameter. This function is 
the upper limit of the random point dropoff range. Changing the value in this field will 
change the tonal values of the starscreened image.



Create Bitmap Frame

Click this icon to create a bitmap frame containing starscreening data. The bitmap frame 
may be exported to a file for use in another document or in a different application. (This 
function only works in the Professional version of the StarScreening module.)



Create CYMK Uniframe

Click this icon to create a high resolution fourplane (CYMK) uniframe that can be exported to 
a file for use in another document or a different application. (This function only works in the 
Professional version of the StarScreening module.)



Show StarScreened Preview

Click the icon to toggle the visibility of a selected starscreened uniframe. The image in the 
uniframe will be hidden and the frame will be covered with an X. 



No Control Line

When this icon is selected, a control line will not be applied to a frame during the 
starscreening process. The specified raster settings will be used with the default control line 
settings. See Set Control Line in Frame Module, chapter 5.



Use Black Control Line

If this icon is selected when you click Create Plane, you will be prompted to select a CK4 
control line for a color frame or CK1 for monochrome. Only the black linearity settings for the
CK4 control line will be used during the starscreening process.



Use Color Separation Control Line

If this icon is selected when you click Create Plane, you will be prompted to select a CK4 
control line for a color frame or CK1 for monochrome. The color separation module must also
be loaded. All control line settings will be used during the starscreening process.



Control Line
Optimized control line files are available for most popular printers. Contact DMC for ordering 
information at:

Tel:    (905) 479-1880
Fax: (905) 479-1882

Compuserve : 76004,2246
Delphi: DMCPUBLISH
Genie: DMCPUBLISH
Internet: DMCPUBLISH@GENIE.GEIS.COM



Delete Module
If you delete the StarScreening module from your set up, all starscreened uniframes will 
appear empty until the module is reloaded. 



Printing StarScreens
To print starscreened frames, the StarScreening module must be loaded. For color frames, 
the Color Separation module is required. 

To output starscreened frames at resolutions higher than 750 dpi, the Professional version of
StarScreening must be loaded on the imagesetter workstation. In addition, control lines must
be used above 750 dpi.

The low resolution (standard) version of the StarScreening module does not support multiple
image processing above 750 dpi. Each image will be processed separately.



Color

The degree of control control offered in Calamus is quite substantial. As a result, a entire 
chapter of the manual has been devoted to it.

Color Settings Module
Focoltone Color Palette 
Color List Converter Module 
CYMK Swap Module 
Color Separation Module 
Linearity Module 



Color Settings Module
The Color Settings module gives you extraordinary power to customize color and fill 
patterns. Study the information in this chapter to understand the options available.

Color Settings Module - Color Lists 
Color Settings Dialog Box 



Color Settings Dialog Box
There are a number of elements in the Color Settings dialog box. It is necessary to have a 
good understanding of these elements if you are going to use color in Calamus.

Color Settings - Color List 
Color Settings - Color Values 
Color Settings - Color System Options 
Color Settings - New/Delete Colors 

Color Settings Module - Insert Spot Color 
Color Settings Module - Insert Palette Color 

Color Settings Module - Edit Spot Color 
Color Settings Module - Patterns 
Color Settings Module - Color Selector 
Color Settings Module - Transparent and Background 
Color Settings Module - Save/Load Color Lists 



Color Settings Module - Insert Spot Color
Spot colors can be printed directly with a single application of ink, so they do not require 
color separation. For example, letterheads and business cards generally have only one or 
two colors. They are usually printed with spot colors rather than by color separation. As a 
result, you cannot control the spot color's tone, only its intensity. If you wish to add a spot 
color to the list, click the Insert Spot Color button and the Edit Color Plane dialog box will 
appear.

You may choose one of the four default colors (Cyan, Yellow, Magenta, Black-K) or create 
your own spot color by using any of three methods. The first method to create a spot color 
starts by clicking the New button. Sliders and color system buttons will appear to the right.

Color Settings Module - Defining Spot Color 

For further information on color palette modules, refer to Insert Palette Color and the 
Focoltone Color Palette module later in this chapter.



Color Settings Module - Insert Palette Color
Palette colors are those colors saved as a group within a particular    module. Swatch books 
are usually available for colormatching and color proofing purposes. Palette colors are also 
known as system colors.

Calamus can use colors from different color systems. If more than one color palette module 
is loaded, you will be asked to select one. When you have selected a color palette module, 
click OK. 

The dialog box of the color palette chosen will appear, allowing you to select a single color:

As you scroll through the color list, the color swatch at the bottom displays the color. Select 



a color and click OK; the selected palette color will be added to the color list in the Color 
Settings dialog box and the Palette Color button on the right side will be selected.



Color Lists

Color lists are found in the command groups of most modules. A color list is composed of 
three basic elements: a free color, a transparent color and named color(s). Where there are 
many named colors, it is possible to scroll through the color list using the vertical scroll bar 
or arrows. It is possible to change the name and color of any color in the color list. To do so, 
doubleclick the color square to the left of the color name. The Color Settings dialog box will 
appear, a complex dialog box with several functions that lead to other dialog boxes. A step-
bystep tour will familiarize you with the possibilities.

The top half of the Color Settings dialog box is divided into three areas. The left area 
contains the list of color names; the middle area contains the sliders; the right area shows 
the color system or color type.

The bottom half of the dialog box contains various buttons to edit color names, access color 
palettes and patterns, view the current color and save/load the current color list. 



Color List
The color list displays all named colors in the current document. Free colors do not appear in
the Color Settings dialog box. To change the name of a color, click it. The color name will 
appear in the edit field, below the list of color names. Change the name and click another 
name to continue.



Color Values
If you wish to change the color of a named color, select the color name and change one or 
more color values by moving the sliders or by entering a percentage in the input fields below
the sliders. Click the percentage displayed and enter the new value from the keyboard. 
Internally, Calamus recognizes 256 positions for each slider. The color intensity will be 
rounded to the nearest of these 256 positions.



New/Delete Colors
To add a new color to a color list, click the New button. The currently selected color name 
will be duplicated with a #2 beside it. In effect, you have made a copy of the previously-
selected color. Now use the edit box to change the color name to something more 
appropriate. Once you have named the new color, use the sliders to adjust the color values. 

If you wish to delete any color from the color list, select the color name and click the Delete 
button. 



Defining Spot Color
Define the new spot color and choose one of the color system buttons. Click New if you wish 
to define another spot color; click OK to enter the spot color in the Color Settings dialog box.

The second method of creating a spot color is to choose one from the Color Selector. Click 
the Color Selector button. The Color dialog box will appear.

Select from the Basic Colors, Custom Colors or directly from the color palette. Click OK and 
the color swatch in the Edit Color Plane dialog box will show the chosen color. Click OK again 
to enter this spot color in the color list in the Color Settings dialog box.

The third method of creating a spot color is to choose one from a predefined color palette. To
do so, click the Insert Palette Color button. If more than one color palette module is loaded, 
you will be asked to select one.

Once you have selected a color palette module, the color palette's dialog box will appear. 
Select the color of your choice and then click OK. The Edit Color Plane dialog box reappears. 
Click OK to enter the selected palette color as a spot color in the color list.



Edit Spot Color
You may wish to change a spot color. Simply select the spot color name in the color list and 
click the Spot Color button at the right side of the Color Settings dialog box. The Edit Color 
Plane dialog box will appear. Follow the steps described above for Insert Spot Color.



Patterns
Calamus has 36 predefined fill pattern styles. If you wish to use one of these patterns, select
a color and then click the Patterns button. The Select Pattern dialog box will appear 

Choose the pattern you wish. It will be shown in the swatch below the patterns. Click OK to 
apply the chosen pattern to the selected color.



Color Selector
The Color Selector allows quick access to any color. You can choose from 48 basic colors and 
define 16 custom colors in the Color dialog box. Click the Color Selector button to call the 
Color dialog box.

You may also select any color from the color palette and adjust its RGB values or its Hue, 
Saturation or Luminescence levels in the input fields. 

After you have defined a color, it can be added to the Custom Colors set. Select a Custom 
Color button and click the Add to Custom Colors button.



Transparent and Background
The Color Selector allows quick access to any color. You can choose from 48 basic colors and 
define 16 custom colors in the Color dialog box. Click the Color Selector button to call the 
Color dialog box.

You may also select any color from the color palette and adjust its RGB values or its Hue, 
Saturation or Luminescence levels in the input fields. 

After you have defined a color, it can be added to the Custom Colors set. Select a Custom 
Color button and click the Add to Custom Colors button.

When the Background button is selected, you can set the background color for a pattern. If 
you do not want a background color, but want to see through a fill pattern, select the 
Transparent button. Note that white will hide everything underneath a pattern, while 
Transparent allows you to see through it.



Save/Load Color Lists
You may use the Save or Load buttons to save or load color lists. Color lists are saved with a 
CFT extension. If a color list is in memory when you choose Load, you will be asked to Merge 
the new list to the current one, or Replace it. Next, the file selector will appear, allowing you 
to choose the desired color list file.

When loading a color list, you will be asked to Merge or Replace the current list. If your 
document contains any colors that are duplicated in the color list you are loading, a Name 
Conflict will occur. For more information, see Name Conflict in Standard Elements, chapter 1.



Focoltone Color Palette

Calamus is supplied with the Focoltone Color Palette. This color palette is designed to allow 
accurate color specification for process color printing.

As an optional module, the Focoltone color palette can be loaded into Calamus at any time 
and can be deleted from memory when not in use. To load,it, select Modules from the File 
menu. When the Modules dialog box appears, click Load and select FOCOLTON.CXM. The 
Focoltone Color Palette is accessed by clicking Insert Palette Color in the Color Settings 
dialog box.

Focoltone Color System 
Focoltone - Using the Color Palette 



Focoltone Color System
The Focoltone Color System provides one of the most advanced process color tint systems in
the design and print industry. It's a quick and simple system that brings the specifier, repro 
house and printer into partnership to ensure that the prepress proof and the printed final 
output match. The Focoltone Color Palette module is provided to allow easy specification of 
Focoltone colors when producing artwork to ensure accurate color.

The Focoltone Color System includes a 763color Swatch Book, a set of 16 Color Charts for 
process color specification and a Color Specifier Chip Book with 5 perforated sample chips of
each color for errorfree communication. The Focoltone Color Specifier Chip Book, Color 
Charts and Swatches are available from DMC as a complete kit or as separate items. A set of
16 Color Charts for Newsprint is also available. These products are designed to enhance the 
use and specification of Focoltone by providing a visual reference for the user.



Using the Color Palette
The Focoltone Color Palette module can be accessed from the Iconbar provided the Iconbar 
has been activated in the Window menu. Clicking the icon will bring up the Focoltone Color 
Palette dialog box.

To find a specific color, enter its name in the field below the list of colors and click the Search
button. The color will be highlighted in the list and will appear in the preview box. RGB 
values will also be shown. The Next button allows you to step through the available colors 
onebyone. Clicking the Save button will save a file with a CTT extension. The CTT file 
contains information for RGB finetuning. A CTT file can be loaded by clicking the Load 
button.

The Focoltone Color Palette can also be accessed from the Color Settings dialog box.



To add a color from the Focoltone color palette to a document's color list, select the Insert 
Palette Color button.

Choose the Focoltone color palette and select a color. Click OK to add the color to the color 
list.

To save the selected color as part of the color list, click Save. A CFT file will be saved. Click 
OK and the selected color will become part of the document's color list. This color list is 
saved with the document and can be accessed by other modules that use this color list.





Color List Converter Module

The Color List Converter changes all free colors in a document to list colors that can be used 
by any module. Free colors are usually found in imported images.

The Color List Converter searches for unlisted colors in two places. First, it will check the free
color in the color list of each command group. (The color at the top of each color list is the 
free color.) Each free color is then catalogued as a list color in each command group. Next, 
the Color List Converter catalogues the colors in all color graphics and adds those colors to 
the color list.

The Color List Converter module is loaded and accessed in the Modules dialog box. To load 
the module, click Modules in the File menu; then click Load and select COLFORM.CXM from 
the MODULES subdirectory.

There is no icon in the Module Row for the Color List Converter so it must be accessed from 
the Modules dialog box. Click Execute in the Modules dialog box.

To start the conversion, click Yes. After the module has created the list colors, an alert will 
appear, indicating that the color list has been updated to include all free colors.

For information about free and list colors, see Color Settings Module.



CYMK Swap Module

The CYMK Swap Module is an easytouse module with a single powerful function. As the 
name states, this module allows you to swap or exchange the color planes in a fourplane 
CYMK color graphic.

This module switches selected planes and produces interesting variations in the color 
display and output of your work.    Experimentation is definitely encouraged.

The CYMK Swap module is loaded by selecting Modules from the File menu. When the 
Modules dialog box appears, click Load and select CYMKSWAP.CXM in the MODULES 
subdirectory. The CYMK Swap Module can be deleted when not in use.

The CYMK Swap module is accessed from the Iconbar. Create an empty raster graphic frame 
and import a fourplane CYMK color graphic. Clicking the icon will bring up the CYMK Plane 
Swapper dialog box, provided you have already selected a frame that contains a fourplane 
CYMK image. 

Select a color plane in each column that you wish to exchange and click OK.    The two color 
planes will be swapped. Remember, this module only works with fourplane CYMK images.



Color Separation Module

The Color Separation module allows you to prepare a document for output by performing the
color separations required to produce different color planes or channels. This aspect of 
Calamus is important and has to be done with precision so that the output is what you 
intended. The Color Separation module is also essential when printing to a color printer.

The Color Separation module is a default module and is loaded when Calamus is launched. 
However, an icon for the Color Separation module does not appear in the Module Row. The 
Color Separation module is executed from the Page Layout command group in the Page 
module or by selecting the module name from the Modules dialog box. As with all modules, 
the Color Separation module can be deleted when not in use or when memory is limited.

Color Systems 
Color Separation in Calamus 



Color Systems
Before discussing the specific functions of this module, we will take a brief look at how color 
is handled. If you want to do further research, you should consult reference material related 
to the topic.

Access the following for additional information about RGB, CYM, CYMK, K, Palette and Spot 
Colors.

RGB Defined 
CYM Defined 
CYMK Defined 

K (Black) Color System 

Palette Colors 
Spot Colors 



Color Separation in Calamus
By using the four process colors, any color tone can be achieved by changing intensity. 
Unfortunately, it is not possible for most printers to print individual points brighter or darker;
a point is either printed or not printed. In color printing, a raster is used to control the 
brightness of individual colors. For additional information on rasters see the Raster 
Generator Module, chapter 3. 

In theory, the color printing process is simple: since all colors in the document are stored 
and displayed in the RGB color system, a conversion into the CYM color system is done first. 
From the resulting colors, the black portion is calculated and subtracted from all three 
process colors. The resulting intensity values are converted into differentsized raster dots 
which are then printed.

Unfortunately, this is only theory. In practice, there are more difficulties that can occur with 
rastering. The greatest problem is the print colors themselves.

Chemical and color industries are unable to supply a color that only absorbs the red portion 
of light and totally reflects green and blue; optimum cyan does not exist, nor does optimum 
yellow or magenta. Mixed together, they produce a rather ugly brown hue which results in a 
loss of contrast when color printing. To compensate for these discrepancies, Calamus uses 
seven control lines.

Color Separation Module - Control Lines 



Color Separation Module - Control Lines
Control lines assign accurate output values to theoretical input values. The control lines of 
the Color Separation module allow you to manipulate the color that is to be separated. You 
can therefore compensate for errors that may occur so that an accurate result can be 
achieved on the output device specified.

Because of the vast number of different output devices and print colors, no single universal 
control line setting exists. It is necessary to have calibrated control lines to have accurate 
color for each output device.

The effect of control line settings can only be seen when a document is printed. 
Experimentation is required before satisfactory results are achieved.

The Color Separation module allows you to define the control lines for a whole document, 
single pages or individual frames. Normally, control lines are set for the entire document. If 
control lines are defined for a specific page, those settings will take precedence over the 
document's settings.    Similarly, frame settings take precedence over page and document 
settings.

Color Separation Module - Using Control Lines 
GCR/UCR Correction Curves Dialog Box 
Control Line Overview - Color Separation Module 
Control Line Adjustment - Color Separation Module 
Troubleshooting - Color Separation Module 



Color Separation Module - Using Control Lines
Select the Color Separation icon from the Page Layout command group in the Page module. 
A dialog box will appear.

You may Apply or Delete control line settings. If a frame has been selected, you may apply 
control lines to the frame, page or document. If no frame has been selected, you may only 
set a control line for Page or Document. 

If they have been previously set, control line settings may be removed from a frame or page.

After selecting an icon, the GCR/UCR Correction Curves dialog box will appear.



GCR/UCR Correction Curves Dialog Box
The GCR/UCR Correction Curves dialog box, provides the tools required to modify the seven 
control lines available in the Color Separation module.

Coordinates - GCR/UCR Dialog Box 
Control Lines - GCR/UCR Dialog Box 
Black Linearity - GCR/UCR Dialog Box ]
CYM Linearity - GCR/UCR Dialog Box 
Black from CYM - GCR/UCR Dialog Box 
Intensity and Contrast - GCR/UCR Dialog Box 
Neutral and Invert - GCR/UCR Dialog Box 
Apply All - GCR/UCR Dialog Box 
Load and Save - GCR/UCR Dialog Box 
OK - GCR/UCR Dialog Box 



Intensity and Contrast - GCR/UCR Dialog Box
The linearity for each channel can be modified by dragging the pointer within the control line
window. Adjustments to the control line can also be achieved by using the Intensity and 
Contrast arrow buttons. Intensity can be manipulated in 256 steps. This is represented by 
the X (input intensity) and Y (output intensity) coordinates. 

Increasing contrast will cause dark colors to become darker and bright colors to become 
brighter. The control line rotates counter clockwise. The color component of the defined 
color is decreased for bright colors when the control line approaches the bottom edge of the 
control line window. The reverse applies to dark colors. The Y(%) coordinates show the 
intensity of the color in percent. 0% represents white or no ink, while 100% is black or full 
ink yield.

You can create a control line parallel to the X axis by pressing the [Shift] key while dragging 
the pointer. When the mouse button is pressed, only its initial position is of consequence.

Freehand or Bezier Options - GCR/UCR Dialog Box 
Gamma Control - GCR/UCR Dialog Box 



RGB Defined
A color monitor is much like a television. Both have a picture tube that uses red, green and 
blue light rays to create various colors on screen.    For instance, if none of the colors is 
present, the color black will result. On the other hand, if all colors are present at their 
highest intensity, the color white will be displayed. Any color shade can be achieved by 
adjusting the levels of the three primary colors: red, green and blue. 

This system works well onscreen but unfortunately does not translate to the printed page. 
Take the color white, for example. As mentioned above, white is created by mixing red, 
green and blue at their highest intensities. If we were to mix red, green and blue paint or ink,
the resulting color would not be white. 



CYM Defined
To accommodate printing presses, another method or system for handling color is required.   
Using the three primary colors (red, green and blue), we can derive the three process colors 
(cyan, yellow and magenta). Cyan is created by mixing green and blue; yellow is created by 
mixing green and red; magenta combines red and blue. The CYM color system is the 
opposite of the RGB color system. All colors combined will produce black, while no colors 
combined will result in white.

Although the CYM color system is closer to the requirements of the printing industry than 
RGB, it is still inadequate. The problem is producing the color black. When cyan, yellow and 
magenta are combined, the result is not black, but dark brown. For this reason, the printing 
industry always prints the color black separately, and does not create it by mixing colors.



CYMK Defined
The addition of black to cyan, yellow and magenta produces the CYMK color system which is 
the standard in the printing industry. Black is achieved by removing gray areas from cyan, 
yellow and magenta. The removal of gray areas is dealt with in detail below.

Colors that have been defined using the CYMK color system will not be processed during 
color separation; they are already defined correctly for each color plane. The CYMK color 
system ensures that a defined color appears in the correct color plane.

Calamus has to display the colors onscreen using the RGB color system; this results in 
deviations onscreen. By correctly setting the color values using the CYMK color system in the
Color Settings dialog box, you will achieve the desired print results.



K (Black) Color System
The K (Black) Color System is primarily used to define grayscales. In this color system, you 
are only able to influence the three primary colors (red, green and blue) in the same ratio to 
each other. The three colors always have the same value. Black is therefore zero for all three
colors. This color system should only be used when creating single color output.



Palette Colors
Palette colors are colors which are defined by the printing industry. Calamus includes the 
Focoltone Color Palette (accessible through the module of the same name). In Calamus, 
palette colors consist of three elements:

- A color name
- A changeable RGB value for representation onscreen
- An unchangeable CYMK value for the print color

The advantage of palette colors is that the defined CYMK values are standardized and have 
been tested in order to provide the best possible color reproduction. If you were to print a 
company logo using its original color, it would be difficult and expensive to accurately 
reproduce the color. The conversion of the original color to a process color equivalent is a 
more economical and precise solution.



Spot Colors
Spot colors are used to match specific tonal values that may otherwise be inaccurately 
created by color separation techniques. A spot color is like any other color in a color list. The 
difference occurs when a document is colorseparated. All colors used in a document, with 
the exception of spot colors, are broken down into their C,Y,M and K color components or 
channels. The spot colors will be output to their own color layer. For example, if a document 
with one spot color is colorseparated, five color layers will be produced: the four process 
colors (CYMK) and the spot color.



Color System Options
You can quickly switch between color systems for any named color by clicking one of the 
color system buttons on the right side. Choose from RGB, K, IHS, CYM and CYMK color 
systems. The sliders will change accordingly. The color swatch in the bottom center will 
remain the same.



Coordinates - GCR/UCR Dialog Box
At the top of the dialog box, the X and Y coordinates for the control lines are shown as 
values (0 to 255) and as percentages. These coordinates refer to the position of the pointer 
when placed on the control line window. The lowerleft corner is 0 or white, while the upper-
right corner is 255 or black.

The control line defines the relationship between the input and output of a color. If the 
control line is placed diagonally from the lower left to the upper right on the coordinate field,
it means that the input value is analogous to the output value; the gravities of the separate 
colors and their color components are neutral.



Control Lines - GCR/UCR Dialog Box
This field allows you to select and edit one of the seven control lines affecting the four 
channels Cyan, Yellow, Magenta and Black. Clicking on the arrow button will display the 
dropdown list of available control lines. The control lines are:

Cyan Black from Cyan
Yellow Black from Yellow
Magenta Black from Magenta
Black 

The control line will appear in the control line window in the color of the channel affected.



Black Linearity - GCR/UCR Dialog Box
A raster cell is assigned to each theoretical black value. The entire black portion can also be 
increased or decreased, thus darkening or brightening the picture. However, insufficient 
black will falsify the color hue; too much black overpowers other colors. To avoid blending or 
ripping off points, the black control line should be flat at the edges.



CYM Linearity - GCR/UCR Dialog Box
These three control lines work like the black control line; a theoretical color value is 
converted to a practical value. These control lines allow you to manipulate the color 
representation; a document which has the cyan control line climbing steeper than the yellow
and magenta control lines will have a greenishblue discolorment. In the same way, a steeper
cyan control line can correct a document that contains too much red when printed.



Black from CYM - GCR/UCR Dialog Box
These three control lines let you define how much of the theoretically calculated black value 
is to be subtracted from the process color, otherwise known as Under Color Removal (UCR). 
This allows you to influence certain (black) color errors with exceptionally dark colors. You 
can also determine, in conjunction with the black control line, the black portion in which UCR
will occur.



Freehand or Bezier Options - GCR/UCR Dialog Box
The middleright section contains two settings for manipulating the control line, and a 
gamma control function. The control line may be adjusted using the Freehand or Bézier 
options. Freehand lets you drag the control line with the cross hair pointer. The Bézier option
places two control points on the control line. Dragging a control point creates a smoother 
curve in the control line and, consequently, smoother tonal changes in the image.



Gamma Control - GCR/UCR Dialog Box
The Gamma control function lets you adjust the darkness of an image without affecting 
shadows or highlights. Gamma settings affect the middle gray levels of an image while 
leaving black and white areas alone. A setting of 1.5 to 1.8 is average. Images shown on 
television typically have a gamma level of 2.2.    The gamma level may also be adjusted for 
the kind of paper used when printing. Highly reflective papers produce middle gray levels in 
a different manner from lightabsorbing surfaces.

To set the gamma level, click the Gamma button and select a level from the dropdown list; 
or enter a custom value in the input field.

Click the camera icon to copy the current control line to the clipboard; click the glue icon to 
paste a control line from the clipboard to the control line window. Use the clipboard to store 
a control line while you experiment with other settings. 



Neutral and Invert - GCR/UCR Dialog Box
The Neutral and Invert buttons let you choose predefined control lines. The Neutral button 
will produce a straight diagonal line from the lowerleft corner to the upperright corner. This 
is also the default setting for control lines. The Invert command button will produce the 
opposite, a control line from the upperleft corner to the lowerright corner. The Invert button 
also performs a function related to contrast. When selected, the control line is mirrored on 
the X axis; dark becomes bright; bright becomes dark. 



Apply All - GCR/UCR Dialog Box
Apply to All will apply the current control line in the control line window to all seven color 
separation control lines. Proceed with caution because the settings cannot be restored. If in 
doubt, use the Save function first and make a copy of control line settings.



Load and Save - GCR/UCR Dialog Box
The Load and Save buttons allow you to record and reuse color separation control lines. 
When you click one of these buttons, the file selector will appear. You may then enter a 
filename for the control line you are saving, or load a previously saved control line. Color 
separation control lines use the CK7 extension. Calamus is shipped with a variety of control 
line settings. These can be found in the CURVES subdirectory.



OK - GCR/UCR Dialog Box
Be careful not to click the OK button until you are certain that you want to use the new 
control line; Calamus will recalculate the values for the image and save them with it. As a 
result, the original data from the image will no longer exist. 



Control Line Overview - Color Separation Module
Color separation control lines define the conversion of all RGB data to CYMK values needed 
for printing. This allows you to set the best possible distribution of color among the print 
color planes. The control lines, also known as linearity curves, allow you to calibrate the 
output device so that the result of a color separation (e.g. 75% cyan) leads to a matching 
color on paper (75% cyan intensity). 

Spot colors do not require their own control lines because they are not separated and are 
printed as is. It is possible to separate spot colors; in this case, the spot color is not printed 
on its own color layer - the control line settings will be applied and the spot color will be 
separated.

The vertical control bar for intensity allows you to alter the ratio of input intensity to output 
intensity for the entire color spectrum. The control line therefore moves up (increases) or 
down (decreases).



Control Line Adjustment - Color Separation Module
To achieve accurate color representation, you should adjust control lines to match the output
device. A document (COLRTEST.CDK) is included with Calamus. One of the elements of this 
document is a grayscale bar (a gradient from 0% to 100% intensity). Separate this color bar 
in four colors and print the result. Adjust the control line as needed. Since the color 
separation only starts at relatively dark color hues, color tinges in bright areas are 
compensated with the control lines 5 to 7 (Cyan, Yellow, Magenta). Discolorment in the dark 
area can be corrected with the UCR control lines (Black from Cyan, Black from Yellow, Black 
from Magenta).

After adjusting control lines, check the other tables for color correctness. If you notice that 
strong colors are being falsified, you can alter the CYM control lines in the upper region, but 
you will have to adjust the UCR control line again after another test print.

The supplied standard control lines have been designed in such a way that UCR only 
operates for relatively dark color hues. Color brilliance is reduced and colors get partially 
discolored if UCR is too strong. Therefore, if you notice irregularities in pictures with darker 
colors, compensate by adjusting the UCR control lines.



Troubleshooting - Color Separation Module
If a picture gets too dark, you can lower the black control line or lower the control lines for 
cyan, yellow, and/or magenta. Color contrast could suffer if the black control line is set too 
low; output may show a brown hue.

Color tinges can be avoided by adjusting control lines or by altering the UCR control line. If 
the result has a red tinge, compensate by raising the cyan control line. The raising of the 
cyan control line in the lower region is only necessary if output has a red tinge in the lighter 
hues.

In a certain way, the GCR/UCR dialog box resembles the Set Control Line dialog box found in 
the Raster Graphic Special Functions of the Frame module. To see the effects of separate 
control lines, load a color image and manipulate the control lines.

Since there is no single way to solve all setting problems, trial and error are recommended. 
Color printing is a complex task. Many test prints are required until satisfactory results are 
achieved. 



Linearity Module

The Linearity module is used to optimize color output. This module allows you to set a 
control line for each color plane. Since color output varies from printer to printer, this 
module will allow you to save specific setup files for each printer.

The Linearity module is not a default module and is not loaded when Calamus is launched. 
To load this module, select Modules from the File menu.    When the Modules dialog box 
appears, click Load and select GRADCUR.CXM from the MODULES subdirectory. If you want 
the Linearity module to load when Calamus is launched, select Save System Setup from the 
Options menu. As with all modules, the Linearity module can be deleted when not in use.

The Linearity module is activated by clicking its icon in the Module Row. The module does 
not have a command group as other modules. Instead, the Color Correction dialog box will 
appear.

The Color Correction dialog box resembles the GCR/UCR Correction Curves dialog box found 
in the Color Separation Module.

Coordinates - Linearity Module 
Color Plane - Linearity Module 



These functions are used to manipulate the color correction control lines in the Linearity 
module. Each function is described in detail in the Color Separation Module, earlier in this 
chapter.

Intensity and Contrast
Freehand, Bézier, Gamma
Clipboard
Neutral and Invert
Apply to All
Load and Save 

Settings for color correction control lines may be saved in files with CK4 extensions. Calamus
is shipped with a number of color correction control lines in the CURVES subdirectory.



Coordinates - Linearity Module
At the top of the dialog box, the X and Y coordinates are shown as values (0 to 255) and as 
percentages. These coordinates refer to the cursor position when the pointer is on the 
control line window. The lower lefthand corner is 0,0 while the upper righthand corner is 
255,255.



Color Plane - Linearity Module
The color correction control line can be modified for each process color plane. To choose a 
color, click the arrow button beside the color name and select the desired color plane from 
the dropdown list that appears. The control line will appear in the selected color in the 
control line window.



Iconbar

This section examines an additional location for holding module icons. Located at the 
bottomleft of the screen, it provides access to modules whose icons do not appear in the 
Module Row.



Screen Refresh
To refresh the screen, press the [Home] key. To abort a screen refresh, press [Control]+[Shift]
+[Alternate] keys simultaneously. These functions work in all view modes for all modules. It 
is particularly useful to abort the refresh of complex vector frames which can take a long 
time. 

 




